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Introduction 

Welcome 
Welcome to HomeRun XL 3.5  Car Dealer Software. The developers of HomeRun 
XL 3.5  Car Dealer Software are experienced business systems professionals who 
know the features that heavy-duty, professional business applications must have. 
You’ll find those features in HomeRun XL 3.5 

This User’s Guide is the place to begin with HomeRun XL 3.5  Car Dealer Software. 
The User’s Guide shows you how to install HomeRun XL 3.5  Car Dealer Software 
and is your main HomeRun XL 3.5  Car Dealer Software reference. 

Why Use HomeRun XL 3.5 Car Dealer Software? 
Here are only a few of the many reasons that you should use HomeRun - The Car 
Dealers Program. 

 Save Money: HomeRun can reduce the money you are spending on pre-
printed forms. All information for a Vehicle Bill of Sale is filled out on 
screen and printed on your laser or bubble jet printer. 

 Ensure Profitability: Even before you print the Bill of Sale for the 
customer, you know exactly how much profit you will be making on the 
sale. 

 Track Expenses: HomeRun allows you to track all expenses associated 
with each vehicle. 

 Track Vehicle Activities: HomeRun allows you to enter and track all your 
activities, Wholesale and Retail Purchases and Sales.. 

 Validate Serial Numbers: HomeRun automatically checks the serial 
number you entered each time you save a record, and informs you if it is not 
a valid serial number. There is also a separate VIN Checker in the program 
so you can check a VIN before entering a vehicle in the program. 

 Validate Vehicle Year:  HomeRun automatically obtains the year of a 
vehicle from the serial number (after it ascertains the number is valid) and 
inserts it into the record when it is saved. 

 Calculate Loan Payments: Allows you to calculate and print Loan 
Payments periods in the Bill of Sale by Monthly, Bi-Monthly, Weekly and 
Bi-Weekly Periods. 

 Wholesale Buy and Sell:  Allows you to purchase and sell wholesale to 
other dealers. Prints Bill of Sale appropriate for the transaction. 

 Vehicle Appraisal:  HomeRun allows you to produce and print Vehicle 
Appraisals. 

 Trade-In Forms:  HomeRun allows you to produce a form for the trade-in 
client to sign for Trade-in Vehicles. 
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 Windows Flyers:  Produce individual professional looking Windows 
Flyers for your vehicles. 

 Reports: Many reports are included with the program such as Vehicle 
Listings, Delivery Schedules, Inventory Valuation Reports, Sales Report 
and Purchase & Tax Reports. 

 Security: Allows you to have full User Security such as Access to the 
program. Fields, such as profit & cost, can be hidden from employees on a 
need to know basis. Menu Security allows you to decide if employees can 
see or access certain form and items. 
 

Who Should Use HomeRun XL 3.5 Car Dealer Software? 
HomeRun is for Used Car Dealers who want to be able to manage their business in a 
Professional and Profitable Manner. 

Although you don’t have to be a computer expert to use HomeRun, you should be 
familiar with the following: 

 The Microsoft Windows operating environment and conventions. 

 If you are going to be using HomeRun in a multi-user environment, you 
should understand basic networking. Especially network and printer 
mapping. 

 The Microsoft Windows operating environment and conventions. 

When You Need Help 
When you need help while working with HomeRun XL 3.5  Car Dealer Software, 
the first place to turn is the HomeRun XL 3.5  Car Dealer Software documentation. 
You can also access the HomeRun XL 3.5  Car Dealer Software documentation in 
the program from the HomeRun XL 3.5  Car Dealer Software Help menu.  

HomeRun XL 3.5 Car Dealer Software Technical Support 
The LeBlanc & Associates is committed to providing the best possible technical 
support for HomeRun XL 3.5. This section describes the technical support resources 
available to you for free and for purchase. 

New User Support 
HomeRun XL 3.5 is predominately sold on a yearly subscription basis. For these 
users, the yearly subscription includes on-line and email technical support and 
training when requirered for the duration of the subscription period. 

We are well aware when someone purchases our product that they will need help in 
setting up and learning to use HomeRun.  

One of the advantages of purchasing yearly support is all the updates and program 
upgrades will be provided free of charge during the paid support period. 

Provided the computer system is on a high speed Internet network, we can offer 
technical support for any Windows operating systems by using Remote Software 
through your web browser by logging into your computer, with your permission, and 
fix any problems you may have. We can also help you with the initial set up of 
HomeRun XL 3.5  as well as show you how certain features work. 
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HomeRun XL 3.5 Car Dealer Software Web 
The HomeRun XL 3.5 Web is the cornerstone of HomeRun XL 3.5  Technical 
Support because it allows us to provide timely support information to users 
throughout the world. The HomeRun XL 3.5 Web's Technical Support pages are a 
valuable resource for:  

 Frequently Asked Questions 

 Descriptions of HomeRun XL 3.5  Support Plans 

You will find everything you need to know about HomeRun XL 3.5 Technical 
Support on the HomeRun XL 3.5 Web Support pages. 

HomeRun XL 3.5 Product Maintenance 
Software must be maintained. As bugs are found or other minor changes become 
necessary, software maintenance updates must be available. All too often, software 
developers do not provide maintenance updates as frequently as they should. Our 
goal is to provide maintenance updates on a timely basis. 

Maintenance updates are made available for download from the HomeRun XL 3.5 
Web. If you are on the yearly support option, you can download maintenance 
updates from the HomeRun XL 3.5 Web for free.  If you need an update shipped to 
you, there will be a charge for materials costs and shipping. 

If you are not on yearly support, we can make updates available to you for a fee. 
Check our web site for information. 

HomeRun XL 3.5 Product Upgrades 
The HomeRun XL 3.5 staff is constantly adding new functionality to HomeRun XL 
3.5. An important part of your purchase of HomeRun XL 3.5 is the assurance that the 
product will continue to evolve with changes in technology. After all, you don't want 
to be stuck with a product that's become obsolete. 

Charges for HomeRun XL 3.5 upgrades are determined and announced at the time an 
upgrade is released.  

HomeRun XL 3.5 Priority Support 
If you need emergency assistance or simply need to know that you can get telephone 
or email assistance when you need it on a priority basis, you may purchase additional 
technical support services through our Priority Support option. Priority Support can 
be purchased on a per incident basis or on an annual basis in sets of 10 or 25 Support 
Units. Priority Support provides the following additional support services: 

 Telephone Support from 9:00 a.m. to 5:00 p.m. EST Monday through 
Friday.  

 Priority Response provides access to senior HomeRun XL 3.5 staff.  

 Priority Email Support lets you submit support requests via private email. 

If you need priority telephone support, call (416) 663-8510. Telephone support hours 
are from 9:00 a.m. to 5:00 p.m. EST Monday through Friday.  

You can also get HomeRun XL 3.5 Priority Technical Support via private Internet 
email. Send Internet email to support@homerunsoftware.net 

HomeRun XL 3.5 Subscription Support 
We now offer HomeRun XL 3.5 via subscription which may be purchased on a 
mostly on an annual plan. 
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While you are on any subscription plan, you will receive the following for the term 
of the purchased support. 

 Telephone Technical or Training support. 

 Email Telephone or Training support. 

 Any updates issued during your subscription period. 

 Any upgrades issued during your subscription period. 

 

Support for Legacy Purchasers 
When we initially released HomeRun,, we sold the program outright. These Users 
received 12 months of support with their purchase. For their purchase fee, they could 
use the program forever. However, if they wanted Support or Updates/Upgrades, 
they have to purchase annual support. These Users who pay our Annual Fee will 
receive the same support as those described above. 

In the case that Support Payment have not been renewed for a period of time, 
Support payment will be calculated from the date the support was not paid to the 
present. Otherwise, these users can purchase an annual subscription. 

HomeRun XL 3.5 Bug Reports 
If you believe you have encountered a bug in HomeRun XL 3.5, send an email to 
info@homerunsoftware.net with a subject line of “Bug Report”. We will evaluate 
your bug report on a non-priority basis. If a bug is indeed found, it will be fixed and 
added to our next update. 

If you believe you need Priority Support to deal with what you believe is a bug, you 
must use the Priority Support process to request Priority Support. That means you 
must currently be on either a subscription period. 

Errors 
As you work with HomeRun XL 3.5, errors may occur. Even the best computer 
software sometimes experiences errors..   

When you run HomeRun XL 3.5, the program will display an error message if it 
encounters an error. When an error occurs, the first thing to do is display the Errors 
form from the Admin menu to view the error data that HomeRun XL 3.5  captures. 
The Errors form will normally provide all the information needed to diagnose and fix 
the error. 

See “Errors” on page 83 for a description of the Errors form. 

Tip: If you need to call LeBlanc & Associates technical support for assistance with 
an error, please have the error data displayed on the Errors form when you call. 

Visual FoxPro and Visual ProMatrix  
HomeRun XL 3.5 has been created using: 

 Microsoft Visual FoxPro: the state-of-the-art object-oriented database 
management and application development system. 

 Visual ProMatrix: the premier rapid application development tool for 
Visual FoxPro. 

While you do not need Visual FoxPro or Visual ProMatrix to run HomeRun XL 3.5, 
there may be advantages to acquiring those two products. If you want to access the 
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HomeRun XL 3.5 data independently of HomeRun XL 3.5  or if you want to develop 
your own applications using the HomeRun XL 3.5  data, you should consider 
acquiring Visual FoxPro and Visual ProMatrix.  

You can purchase Visual FoxPro from Microsoft or any full-line software retailer. 
Contact the ProMatrix Corporation to purchase Visual ProMatrix:  

ProMatrix Corporation 
5225 Ehrlich Road 
Suite C 
Tampa, Florida 33624 
(800) 889-7058 
(813) 960-5938 
Fax: (813) 960-7231 

Where to Go from Here 
Here’s the approach we recommend for using the User’s Guide:  

 Start with the Installation chapter to learn how to install HomeRun XL 3.5   

 Follow the instructions in the Setup chapter to make sure you have 
HomeRun XL 3.5 set up the way you want to use it. 

 Review the Overview chapter to experience the flavor of how HomeRun XL 
3.5 works. 

 Work your way sequentially through the remainder of the User’s Guide. 
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Installation 

Setting up your Network and Backup Considerations 

Setting up your Network Considerations 

Wired vs Wireless Network 
Any database type program will not work well under a wireless network. This 
applies to HomeRun Software programs, Accounting Software or any other program 
that reads & writes data from a workstation computer to a main/server computer. The 
reason is basically that Database programs require a constant connection to ensure 
that the data is written back to the Server. Wireless networks by nature do not offer a 
continuous connection.  

Most of the time we have received a call from a Client complaining that they get a 
"non recoverable program data error" they were running one or more computers 
wirelessly on a network. 

The other reason is that they had a power failure and when the power came back on, 
they found corrupted data. 

Basic Minimum Network Requirements 
The following is the minimum requirements to ensure that your Network is set up in 
such a manner that will protect your data. 

 Ensure that you have your Main/Server computer plugged into a UPS 
Battery Backup with a minimum uptime of 1 hour. (This will allow you to 
close programs and shut down the system) 

 Ensure that your Internet Modem, Router & Switches are plugged into this 
or another UPS Battery Backup. 

 Ensure that your Workstations are also plugged in a UPS Battery Backup 
with sufficient backup time to enable you to close any program. Remember, 
it will do you absolutely no good to have the server & network equipments 
up and running if a Workstation suddenly closes while working on a 
program with files open. 

 Arrange to perform a backup daily for all the data that you regularly use. i.e. 
HomeRun, Accounting Data, Spreadsheets and other data. Remember to 
take the data off-premises. If you have a fire or other calamity, it will do 
you no good to have your data backups done and up in flame with your 
computers. Another reason to have a current backup is if there is a problem 
with your data, it’s a simple matter to restore the corrupted files from 
yesterday’s backup.  

 



8    Installation HomeRun XL 3.5 Car Dealer Software 

HomeRun XL 3.5 Installation 
HomeRun XL 3.5 is a true multi-user program. You can install on a single computer 
or if you have networked computers, you can install the data on 1 computer (Server) 
and install the base program on the other computers on your network and map to the 
data on the server computer. 

To install HomeRun XL 3.5, you will need to download the file(s) from the Internet 
using the link supplied in the email you received when you purchased HomeRun. 

The Main Setup file is to be used for either Single User or a Server Installation. This 
is where the data will be stored 

The Workstation setup file is to be used to perform a setup on network computers. 
The Workstations will use the data stored on the Server computer. 

Important: You cannot simply copy files from the CD or Setup Disks to your hard 
disk. You must use the Setup program to decompress and install the HomeRun XL 
3.5 files into the HomeRun XL 3.5 directories. 

Before You Begin Installation 
Before you install HomeRun XL 3.5, make sure that your computer meets the 
minimum requirements.   

Hardware and System Requirements 
To run HomeRun, your computer system must meet these minimum requirements: 

 Any IBM®-compatible computer with a Pentium 4 2.4 Hz processor or 
higher. 

 A mouse. 

 4 GB Minimum – 8 GB Recommended 

 A hard disk with 107 megabytes of free space. More space will be required 
for your data. 

 VGA or higher resolution monitor set at 1024 x 768 Screen Size. 

 Windows XP Professional, Vista Business, Windows 7or 8 Proffessional. 
HomeRun is a business application and as such requires a Business 
Operating system. . Windows XP Home/Vista Home is not a business 
operating system and as such is not recommended. In addition, we will not 
offer support on system problems if you are running these home operating 
system. 

 Installed Windows fonts: Arial, Courier New and Times New Roman 

 

Running Setup 
Begin the HomeRun XL 3.5 installation process by running the Set up file 
downloaded from our Server. Download both the Main/Server and Workstation Seup 
files. 
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Setup for a Single User or Main Network Computer. 

 To run Setup 
1. Start Microsoft Windows. Close all other Windows applications. 

2. Installation from Exe File: If you are installing HomeRun from exe file 
that you download from the HomeRun web site, create an empty directory 
and place the file(s) into that directory or save to your Desktop so it will be 
easier to find. Run the downloaded file from the directory that contains the 
EXE file. 

3. Setup displays a Dialogue box telling you that it will install HomeRun in 
the C:\Program Files\HomeRunXL3.5 directory.   

4. Follow the instructions on the screen. 

5. Setup ends. You’ll see a Windows Start menu entry for HomeRun. A 
shortcut will also be placed on your Desktop. You can now run HomeRun 
from the HomeRun Start menu or Desktop options. 

The next step is to run HomeRun to complete the installation. Before starting to use 
HomeRun for the first time, you will need to enter certain information identifying 
your company and certain licence numbers that are specific to your company. The 
“Running Home Run for the First Time” section tells you how to do that. But first, 
read the next section to see what Setup has installed and to check your setup.  

Very Important: Read and follow the instructions in the “Creating Security 
Recovery Files” section below to make sure you can recover if you implement 
HomeRun’s Security Option and accidentally lock yourself out of HomeRun after 
setting up HomeRun’s Security tools.  

Setup for Networked Workstations 
A Workstation setup installs the main HomeRun program files and the necessary 
support files required to run HomeRun on an individual computer. The Data is stored 
on the Server or Main computer and is used by all workstations. 

Before doing a Workstation installation, ensure that you have the HomeRun Folder 
on the Main/Server computer set up for Sharing. The folder to be shared is the 
HomeRun XL 3.5 folder. Check the Security settings for the shared folder to ensure 
that other users accessing this folder have permission to change the data. 

 To run Setup 
 

1. Before starting the Workstation install, you must map the HomeRun 
data path to the Server or Main computer. Our recommendation is that 
you map drive “H” to the main HomeRun folder. You may use any drive 
letters you wish, however, it is a good practice from an administration point 
of view to map each workstation the same. If you don’t know how to set up 
a Share on one computer and set up the mapping from other computers to 
this share, you may want to get a Computer Professional to do this for you. 

2. Start Microsoft Windows. Close all other Windows applications 

3. Installation from downloaded file: Run the HRSTATIONSETUP.EXE 
file that you downloaded from the web. 

The steps from here are the same. 

4. Setup displays a Dialogue box telling you that it will install HomeRun in 
the C:\HomeRun Software\HomeRunXL3 directory.   
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5. Follow the instructions on the screen 

6. After setup is completed, the Workstation setup screen comes up. Enter the 
path to the Data and Report folders. Assuming that you mapped Drive H to 
the Homerun folder on the server, your entries should look something like 
this. When you are finished entering the information, Click Apply and then 
OK. 

 
7. Setup ends. You’ll see a Windows Start menu entry for HomeRun. A 

shortcut will also be placed on your Desktop. You can now run HomeRun 
from the HomeRun Start menu or Desktop options. 



 

HomeRun XL 3.5 Car Dealer Software Installation    11 

What Setup Installs 

HomeRun Directories for Single User/Server 
For Single User or Network Installation on the Main or Server computer, Setup 
creates a \HomeRunXL3 directory on your hard disk with the following 
subdirectories and copies the HomeRun files to these directories: 

Subdirectory Contents 

\DATA Table files used by HomeRun and applications. 

\REPORTS Report files used by HomeRun and applications. 

HomeRun Directories for Network Users 
Network Installation Setup creates a \HomeRun directory on your hard disk with the 
following subdirectory. The folders containing the Data and Reports will be located 
on the Server or Main computer. 

Subdirectory Contents 

\DOCUMENT A copy of the manual in Adobe PDF Format. 

 

 

Registering HomeRun to Use 
Registering HomeRun is a 2-step process. The Process is the same for the 
Main/Single User or Workstation installation. All computers running HomeRun must 
be licenced. 

 To Register HomeRun  
1. When the Registration Form appears, click the Enter Key 
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2. Enter the Name and Key EXACTLY as given to you in appropriate box. 

You should use the Copy and Paste function to enter the information. Click 
OK. 

 

. 

Running HomeRun the First Time 
Filling in the items under Company Menu Items under Admin Main Menu. This 
section is not required for Workstation setup. 

� To initialize HomeRun 

1. From the Windows Start menu, start HomeRun by selecting the HomeRun 
menu option. If HomeRun doesn’t run, review the proceeding “What Setup 
Installs” section. 

2. When HomeRun XL 3.5 first starts, the Program Registration form is 
shown. See below on how to request Registration Keys. You can access 
or change your registration information by clicking on Help -> 
Registration on the main menu. 

3. All of the items you need to initially fill out before you start using 
HomeRun will be found in the Admin->Company Information Menu 
Tab. 

4. Fill out your company information in the Basic Company Information 
section. This is where the program gets the information to print on all 
forms used by this program. 

5. Then fill in the Numbers Used section. Default numbers have been 
entered so you can start using the program right away. Change these 
numbers as appropriate. 

6. Then enter in the Information on all your Employees especially the 
Salesperson Licence Number. You can access the Employees screen by 
Clicking on Data ->Employees -> Employees from the main menu. 

After you initialize HomeRun, you can run HomeRun at any time by Clicking the 
HomeRun icon on the Program Start Menu or the Desktop. 
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Performing Backup of Program and Data 
As with all programs installed on your computers, it is necessary to perform data 
backups on a timely basis. This process can be as simple as copying the HomeRun 
XL 3.5 files from your hard drive to CD/DVD Disk or to USB Disks. Another option 
is to use backup software to automate the procedure. There is backup software 
installed in Windows. This will allow you to set up backups as sets and perform the 
backups to any media. The Windows supplied program is a simple and difficult 
program to use. 

We are using the Professional program from Genie-Soft and have been using it for 
many years.  

You can find information on Genie Backup Manager 9.0 Pro at 

 http://www.genie9.com/business/genie_soft_business_solutions.aspx 

 

It is always best to backup or copy the entire HomeRun XL 3.5  folder. In this 
way, you will have the complete backup to restore in the case of disk failure or 
corruption. The least you should backup is the the Data Folder. Assuming that 
you have installed the program with the defaults, you can find the program and 
data under C:\HomeRun Software\HomeRun XL 3.5  

Here are some of the horrow stories we get regarding backup … or lack thereof: 

 

 Our Officewas broken into last night (or on the weekend) and someone stole all 
of our computers. 

 

 Another tale of woe is that the Hard Drive crashed and all of their data is now 
gone. We’re sorry to tell you that there is nothing we can do to help recover 
your data.
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Setup 

HomeRun XL 3.5  Setup 
HomeRun XL 3.5 Car Dealer Software includes Administrative Tools that help you 
manage HomeRun XL 3.5 Car Dealer Software and monitor your use of it.  

 
The options on the HomeRun XL 3.5 Car Dealer Software Admin menu allow you to control 
and use the Administrative Tools. 

The most important area for you to initially set up is the Company Information items 
found on the Admin Menu. 

Detail instructions for each of these items are shown later in this manual. 

The following items should be filed in BEFORE going further with the program. 

1. Basic Company Information:  Enter your address and telephone numbers. 

2. Dealer & Tax numbers: Enter these numbers. This is where we get this 
information to display in the Bills of Sale. 

3. Tax Rate: Simply review these. They should be accurate but check them to 
be sure. 

4. Bill of Sale Default Values: If you always have certain charges on all 
Retail Bill of Sale, filing them in here will ensure they are not missed. The 
values entered here will automatically be entered when you enter a new Bill 
of Sale.  

5. Last Numbers Used: HomeRun keeps track of your last sales numbers, 
stock numbers etc…and increments them as required. 



16    Setup HomeRun XL 3.5 Car Dealer Software 

6. Logo Information: If you intend of using your logo on your Retail Bill of 
Sale, you must fill out this information. 

Important: After you install HomeRun XL 3.5 Car Dealer Software, visit the 
Admin menu to set up the Administrative Tools as you prefer. 

The tools you may want to set up before you begin using HomeRun XL 3.5 Car 
Dealer Software are described below. 

HomeRun XL 3.5 Environment 
You can control the HomeRun XL 3.5 environment through the Environment option 
on the Admin menu. 

 
    The Environment dialog lets you customize the HomeRun XL 3.5 environment. 

The environment settings are described below. You can change the environment 
settings as needed. 

Confirm 
Specifies whether the Enter or Tab key must be pressed to exit an input field on a 
form. When Confirm is checked, you must press Enter or Tab to move to the next 
object on a form. When Confirm is unchecked and the cursor reaches the last 
character in an input field, the cursor moves to the next object and the bell sounds if 
the Bell check box is checked. 

By default, Confirm is unchecked. 

Exit Confirm 
When you exit HomeRun XL 3.5, a dialog appears to confirm your exit. This dialog 
prevents accidentally exiting HomeRun XL 3.5. However, some people are annoyed 
by the confirmation dialog. If you’re in the latter group, you can turn off the exit 
confirmation by unchecking the Exit Confirm check box. 



 

HomeRun XL 3.5 Car Dealer Software Setup    17 

Clock 
If you want to display a clock in the HomeRun XL 3.5 window, you can choose the 
row and column for the clock’s display. You can also choose to display the clock in 
the status bar.  

Bell 
Turns your computer bell on and off. If the Bell check box is checked, your 
computer bell will sound during editing when you reach the end of a field or enter 
invalid data. 

Date 
Specifies the format for the display of dates on forms. The default format is 
American (mm/dd/yy). The drop down combobox lets you choose different formats 
based on country or the placement of mm, dd and yy.  

The Separator specifies the character that separates mm, dd and yy in the date format 
selected. The default Separator is “/”. 

 Century: A number from 1 to 99 that specifies the current century. When a 
date in HomeRun XL 3.5 has a two-digit year, the Century entered determines in 
which century the year occurs.  

Rollover Year: Determines whether the year is in century or the century following 
this Century. A number from 0 to 99 that specifies the year equal to and above which 
is the current century and below which is the next century. The default value is the 
last two digits of the current year plus 50 years - if the current year is 1998, Rollover 
Year is 48, the last two digits of 2048 (1998 + 50). Note that the rollover value only 
determines the century for a date entered without a century portion - an ambiguous 
date format that is not recommended. For example, if the current year is 1998 and 
Rollover Year is the default (48), any date entered without a century portion and a 
year of 48 or greater is considered to be in the current century (the 20th century). 
Any date entered without a century portion but with a year before 48 is considered to 
be in the next century (the 21st century). 

Report Mgr Type 
Currently we do not use the Report Manager. All the reports you will require can be 
accessed from the “Report” Menu Item. 

. 
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Directories 
The Directories option on the Admin menu displays the HomeRun XL 3.5 Home, 
Tables and Reports directories.  

Tables: A table is a special type of file used to hold HomeRun XL 3.5 data.  

 

Tip: You can use the Directories dialog to change the Tables and Reports 
directories. You may want to change the Tables and Reports directories if you need 
to share HomeRun XL 3.5 data files with other users on a Local Area Network 
(LAN) - see below. 

Home Directory 
The HomeRun XL 3.5 Home directory is where the main HomeRun XL 3.5 files 
were placed when you installed HomeRun XL 3.5. You cannot change the HomeRun 
XL 3.5 Home directory through the Directories dialog. 

Tables and Reports Directories 
HomeRun XL 3.5 automatically stores any new tables and reports you create in the 
Tables and Reports directories. You can change the Tables and Reports directories 
by entering new directory paths in the Tables and Reports fields on the Directories 
dialog. If the new directories you enter don’t exist, HomeRun XL 3.5 will create 
them for you. 

By default, the Report Directory is empty. All of the reports are compiled and 
included within the HomeRun EXE file. 

When would you want to change the Tables and Reports directories? You may want 
to change the Tables and Reports directories when you install HomeRun XL 3.5 on a 
LAN and need to share data files among users on LAN workstations. See the next 
section for a complete discussion of this LAN topic. 

  

Installing HomeRun XL 3.5 on a LAN 
HomeRun XL 3.5 is a multiuser application. That means more than one user or 
workstation on a LAN can access and share the same HomeRun XL 3.5 files. Here’s 
how we recommend that you set up HomeRun XL 3.5  so that more than one user 
can access data and report files at a time. 
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 To Set Up HomeRun XL 3.5 on a LAN 
1. Install HomeRun XL 3.5 on each LAN workstation’s local hard drive using 

the workstationsetup.exe 

2. At the end of the set up process, you will be prompted for the location of the 
data and report folder. This is a prerequisite for HomeRun to be able to run 
from a workstation. 

3. If you have missed this step, use Windows Explorer to get to the 
Folder/Directory where you installed HomeRun on the workstation. If you 
accepted the default folder location during the set up, this would be 
C:\HomeRun Software\HomeRunXL3.5.  Run the file set_directories.exe 

Review 
In the next chapter, we’ll go over some basic mechanics that will help you 
understand and use HomeRun XL 3.5 better. Before we do that, let’s take a moment 
to review what we’ve learned in this chapter. Here are some important points that we 
would like you to remember. 

 HomeRun XL 3.5 includes Administrative Tools that help you manage and 
monitor your use of it. 

 You access the Administrative Tools through the Admin menu. 

 You can turn many of the Administrative Tools on and off through the 
Admin Tools option on the Admin-Security menu. 

 HomeRun XL 3.5 Security gives you greater control over who can access 
HomeRun XL 3.5 and what they can access. See the Security chapter for all 
the details. 

 You can customize the HomeRun XL 3.5 environment through the 
Environment option. 

 If you are installing HomeRun XL 3.5 on a LAN, the Directories option lets 
you tell each workstation where shared data and report files are located. 

To see more detail about the topics covered in this chapter, refer to the appropriate 
chapters elsewhere in this User’s Guide. 
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Using HomeRun XL 3.5 

Some Things You Should Know 
There are some things you should know before you begin using HomeRun XL 3.5 

When you first learned to drive a car, the main things on your mind were all the great 
places the car would take you and the freedom to go whenever you wanted. You 
quickly learned, however, that there were some basic, mechanical things you needed 
to know before you could drive your car anywhere.  

So it is with HomeRun XL 3.5 You want to jump right in and start using HomeRun 
XL 3.5 However, there are some basic things that you need to know. This chapter 
identifies the basic mechanics that will help you understand and use HomeRun XL 
3.5 better. You will get to your destination faster if you take the time to review 
what’s here. 

HomeRun XL 3.5 Toolbar 
The HomeRun XL 3.5 Toolbar has buttons that let you quickly access special 
functions. 

 
Button Purpose 

Activates the Report Manager. 

 Displays the HomeRun XL 3.5 Startup Form when accidentely 
closed (that is the screen above) 

Will print the current active screen or window 

 

HomeRun 
Toolbar 
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HomeRun XL 3.5 Form Toolbar Controls 
HomeRun XL 3.5  forms have toolbar control push buttons. The toolbar control 
buttons let you view and manage data in tables.  

 
The HomeRun XL 3.5 Form Toolbar 

You need to learn how the toolbar control buttons operate. The Data Entry chapter 
lists the HomeRun XL 3.5 toolbar controls and describes how they operate. Please 
review the Data Entry chapter so you’ll know how to use HomeRun XL 3.5 forms. 

Shortcut Menus 
When you right-click on a form or form field, HomeRun displays a shortcut menu of 
options appropriate for the form or field.  

 
Forms Shortcut Menu 

 
Fields Shortcut Menu 

 

Escaping from Invalid Data 
If you encounter an input field that fails validation while you’re editing data on a 
form in HomeRun, you may press Esc to exit the HomeRun validation routine and 
cancel the data changes you made on the form. 

 

Special Keys 
The following table shows Function and Control key shortcuts that you can use while 
you’re running HomeRun XL 3.5 

Function and Control Key Shortcuts 

Key Action 

F1 Activates context-sensitive menu and screen help. 

F2 Activates field help picklist for current field. 

F3 Activates field help text for current field. 

Alt + F3 For users with this permission, activates field help text for 
current field and lets user edit the text. 
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Ctrl + Y Exit HomeRun XL 3.5 

Ctrl + X Cut. 

Ctrl + C Copy. 

Ctrl + V Paste. 

Ctrl + B Toolbar Parent Mode control. 

Ctrl + F Toolbar Find control. 

Ctrl + H Toolbar Locate control. 

Ctrl + L Toolbar List control. 

Ctrl + I Toolbar Filter control. 

Ctrl + O Toolbar Order control. 

Ctrl + P Toolbar Print control. 

Ctrl + Home Toolbar First record control. 

Ctrl + PgUp Toolbar Prior record control. 

Ctrl + PgDn Toolbar Next record control. 

Ctrl + End Toolbar Last record control. 

Ctrl + N Toolbar New control. 

Ctrl + K Toolbar Copy control. 

Ctrl + U Toolbar Edit control 

Ctrl + D Toolbar Delete control. 

Ctrl + G Toolbar Group Delete control. 

Ctrl + M Toolbar More control. 

Ctrl + E Toolbar Save control. 

Ctrl + T Toolbar Cancel control. 

Ctrl + F4 Toolbar Close control. 

 

Where to Go from Here 
Read the next chapter, Overview, to get an overview of how HomeRun XL 3.5 
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Overview 

HomeRun XL 3.5 Overview 
This chapter provides an overview of how HomeRun XL 3.5 will help you run your 
business. It also describes the HomeRun XL 3.5 interface and takes you on a brief 
tour of the HomeRun XL 3.5 menus. Later chapters describe each feature of 
HomeRun XL 3.5 in more detail. 

Read the “What is HomeRun XL 3.5” section for an overview of how HomeRun XL 
3.5  does its job and what it can do for you. Skim the “HomeRun XL 3.5 Interface” 
section to get a feel for how the HomeRun XL 3.5 menus are organized. Then, use 
the “HomeRun XL 3.5 Interface” section as a quick reference to the purpose of each 
HomeRun XL 3.5 menu option. 

What is HomeRun XL3.5? 
HomeRun XL 3.5 is your complete sales and management tool. 

 
HomeRun performs the following major functions:  

 Manage Client Contacts 

HomeRun will allow you to manage all your business contacts. 

 Manage your Vehicle Inventory 

 HomeRun will allow you to manage your Car Inventory. You will be able 
to track all the expenses associated with any of your current and previous 
car inventory. 
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 Retail Bill of Sale 

  HomeRun woll allow you to enter and track Bill of Sale for Vehicles sold. 
It will also allow you to print professional looking Bills of Sale. 

 Manage after Sales Products 

 HomeRun will allow you to keep track of the items you keep in stock that 
you sell to your Clients. Also, HomeRun allows you to invoice these items. 

 Manage the Selling and Buying of Wholesale Vehicles 

 HomeRun allows you to produce Purchase Agreements for your Wholesale 
Purchase of Vehicles. Also, when you sell cars to other dealers, HomeRun 
allows you to produce and keep track of these sales. 

 Windows Flyers 

 HomeRun allows you to produce Windows Flyers detailing information 
about any vehicle in your inventory. 

 Vehicle Appraisals 

 HomeRun allows you to produce Vehicle Appraisals for a fee and print a 
appraisal for a Client. 

 Payment Loan Calculator 

 HomeRun allows you to calculate various loan and payment options for 
your Clients prior to producing the Retail Bill of Sale. 

 Floor Plan 

HomeRun allows you to enter and track vehicles that belong to various 
floor plans and to produce reports based on various criteria 

  

Why You Need HomeRun XL 3.5 
In today’s complex business environment, it is becoming more difficult to 
consistently produce profitable sales. HomeRun allows you to Professionally 
Manage your entire operation from Sales Leads to completed Sale. 
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HomeRun XL 3.5 Welcome Form 
When you run HomeRun XL 3.5, you’ll first see the HomeRun XL 3.5  Welcome 
Form.  

 
 

Click Continue to enter HomeRun XL 3.5 Click Exit to leave. 

If you want to redisplay the Welcome Form while you are using HomeRun XL 3.5, 
select the Welcome Form option on the HomeRun XL 3.5 Help menu. 

HomeRun XL 3.5 Menu 
The HomeRun XL 3.5 menu organizes your access to HomeRun XL 3.5 

 
The HomeRun XL 3.5 menu offers many options. The following sections provide an 
overview of each menu. Use these sections as a reference guide to the menu options.  
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File Menu 
The following table briefly describes the File menu options. 

 

File Menu 
Option Purpose 

Reindex/Pack Tables Utility to reindex and pack HomeRun XL 3.5  tables. This 
procedure should be performed every few weeks. 

Exit Closes HomeRun XL 3.5  If the Exit Confirm box is 
checked on the Admin menu Environment dialog, a dialog 
appears to confirm the intent to exit. 

Edit Menu 
The following table briefly describes the Edit menu options. 

 

Edit Menu 
Option Purpose 

Undo Cancels the last text change in a field, record or file. 

Redo Reverses the last undo. 

Cut Removes text from a field, record or file and places it on the 
clipboard. 

Copy Copies selected text to the clipboard. 

Paste Inserts a copy of the clipboard contents into the current field 
or file. 

Clear Clears, or deletes, selected, or highlighted, text. 

Select All Selects, or highlights, the entire contents of a field. 

New Form Toolbar control. Displays blank form fields for adding 
a record to a table.  

Copy Form Toolbar control. Copies the current record and 
displays the copy for editing.  Used to add a record and 
carry values from the current record to the new record. 

Edit Form Toolbar control. Puts form in edit mode for forms that 
have an edit mode.  

Delete Form Toolbar control. Deletes the current record from the 
table. 

Group Delete… Form Toolbar control. Brings up the Group Delete dialog 
for deleting records using condition expressions created by 
the user.  Deletes all records meeting the conditions entered. 

More Form Toolbar control. After entering a new record, clicking 
the More control saves the record and adds a new blank 
record. 

Save Form Toolbar control. Saves data entered while adding, 
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Copying or editing a record and ends the add or Copy. 

Cancel Form Toolbar control. Cancels data entries and changes 
made while Adding, Copying or editing a record and 
terminates the Add or Copy. 

Close Form Toolbar control. Closes the current form. 

View Menu 
The following table briefly describes the View menu options. 

 

View Menu 
Option Purpose 

Parent Mode Form Toolbar control. Turns Parent Mode on and off for 
child forms. 

Find… Form Toolbar control. Brings up the Find dialog for finding 
a record. 

Locate… Form Toolbar control. Brings up the Locate dialog for 
locating records. 

List… Form Toolbar control. Provides a picklist grid with 
incremental search and sortable columns for finding records 
quickly and easily. 

Filter… Form Toolbar control. When no record filter is set, brings 
up the HomeRun XL 3.5  Condition Builder for creating a 
record filter. Otherwise, turns filter off. 

Order… Form Toolbar control. Lists the table’s index tag 
descriptions for selecting the record display order. 

Print Form Toolbar control. Displays the HomeRun XL 3.5  
Report Manager. 

First Form Toolbar control. Displays the first record in a table as 
defined by the record Order and Filter. 

Prior Form Toolbar control. Displays the prior record in a table as 
defined by the record Order and Filter. 

Next Form Toolbar control. Displays the next record in a table as 
defined by the record Order and Filter. 

Last Form Toolbar control. Displays the last record in a table as 
defined by the record Order and Filter. 
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Data Menu 
The Data Menu provides access to the data entry forms in HomeRun XL 3.5 

 

Data Menu 
Option Purpose 

Clients & Contacts Enter & View Contacts and Client Information 

Vehicle Information  Displays the options for displaying Vehicle Information  

   Vehicle Information… Displays the Vehicle Information Form 

Enter repair 
Expense… 

Displays the form to enter and manage Vehicle repair 
expenses 

Purchase Bulk 
Vehicle… 

Displays the form to enter bulk vehicle purchases. 

    Windows Flyers Displays the form to allow you to produce Windows 
Flyers 

     Trade-In Information Displays the form to allow you to produce Trade-in 
Information on your trade vehicles. 

Retail Bill of Sale Displays the Retail Bill of Sale form 

Wholesale Buy/Sell  Displays the options for the Wholesale Buy and Sell 
options. 

    Purchase Wholesale Displays the Wholesale Purchase Form. 

    Sell Wholesale Displays the Wholesale Sales Form. 

Employees   Displays the options to manage Employee Information 

   Employees… Displays the form to manage Employee information 

   Employee Position… Displays the lookup table to allow you to enter employee 
title or position which is used in the main Employee 
information form 

Payment Loan Calculator Displays the Loan Calculator Form 

VIN Checker Displays the form that allows you to check the validity 
of a VIN. 

Check Duplicate VIN Displays the form to allow you to check if a particular 
Vehicle is in your Vehicle Table. 

Lookup Tables  Displays the options to enter information to the lookup 
tables that are used within the program. 
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Reports Menu 
The Reports menu provides access to the HomeRun XL 3.5 Report Manager and to 
reports run from menu options. 

The following table briefly describes the Reports menu. 

 

Reports Menu 

Option Purpose 

Inventory Listing Displays the form to run the Inventory Listing Report 

Delivery Schedule Displays the form to run the Delivery Schedule 

Inventory Valuation 
Report 

Displays the form to run the Inventory Valuation Report 

Sales Reports Display the form to tun the various Sales Reports 

Purchase & Tax 
Reports  

Displays Tax Report Options 

 …Wholesale 
Purchase Sales Tax 
Report… 

Prints the Wholesale Sales Tax Report 

…Wholesale Sell Tax 
Report 

Prints the Wholesale Sell Tax Report 

 …Retail Sales Tax 
Report 

Prints the Retail Sales Tax Report 

Garage Register Prints the Garage Register 

Sales Followup 
Report 

Prints the Sales Followup Report. 

Sales Comparison 
Report 

Prints the Comparison Report which will allow you to 
compary sales for various periods. 

Vehicle Expense 
Report 

Prints the Vehicle Expense Report. 

Report Manager... We have left this in for legacy report purposes and are not 
currently using it. 

The HomeRun XL 3.5 Report Manager is described in detail in the Reports chapter. 
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Admin Menu 
You manage and control HomeRun XL 3.5  through the Administrative Tools found 
on the Admin Menu. 

The following table briefly describes the Admin menu options. 

 

Admin Menu 
Option Purpose 

Company Information This menu item displayed the company setup 
information 

…Basic Company Information This item allows you to enter and maintain your 
Address and Telephone Numbers. 

…Dealer & Tax Numbers This item is where you enter your Dealer RIN and 
other numbers 

…Tax Rate This is where the tax rates charged by the program 
are read from. As tax rates change, this is the 
location where you change them. 

…Dealer Insurance 
Information 

This is the location where you enter your insurance 
information. This information is used when you 
use the “Print Dealer Information”  report below 

…Last Numbers Used This is where you maintain the numbering 
sequence for Stock Number and Bill of Sale. 

…Print Dealer Information This allows you to print your Dealer Information 
when you have to give this information to 
suppliers. 

Logo Information Allows you to enter the name & location of the 
logo to use on Retail Bill of Sale. 

Security  Displays the Security Menu Options 

…Users Displays the User Form 

…Passwords Displays the Password Form 

…User Reports Displays the User Reports 

…Password Reports Displays the Password Reports 

…Control Permission Groups Displays the Control Permission Form 

…Field Permission Groups Displays the Field Permission Form 

…Menu Permission Groups Displays the Menu Permission Form 

…Admin Tools Displays the Security Admin Tool Form 

Activity Displays the Program Activity Report Form 

Audit Trail. Displays the Program Audit Trail Report Form  

Errors... Lists errors that occurred while users worked in 
HomeRun XL 3.5   

Directories... Display's HomeRun XL 3.5 directories and allows 
the HomeRun XL 3.5 tables and reports directories 
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to be changed. 

Environment... Enables setting of system and environment 
parameters for HomeRun XL 3.5 

 

Window Menu 
The Window menu lists the forms, or windows, that you have opened in the 
HomeRun XL 3.5 Desktop window. 

Help Menu 
The HomeRun XL 3.5 Help menu contains options for accessing HomeRun XL 3.5 
Help. The Help menu also provides access to desk accessories, such as a Filer, 
Calculator and Calendar/Diary. 

The following table briefly describes the Help menu options. 

 

Help Menu 

Option Purpose 

HomeRun User 
Manual 

Runs the User Manual 

About...  Displays information about HomeRun XL 3.5   

Startup Form Displays the Startup Form. 

Registration 
Information 

Displays the Registration Information Form. 

Welcome Form… Displays the HomeRun XL 3.5  Introductory Form. 

Calculator Displays a Calculator for basic mathematical operations. 
Can cut and paste results. 

Calendar/Diary Displays a Calendar/Diary for appointments and notes.   
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Data Entry 

Overview 
This chapter begins by explaining how to use the HomeRun XL 3.5 Form Toolbar 
controls. The Form Toolbar controls let you select records, navigate among records 
and update records on a form.  

Then, the chapter describes how to use the HomeRun XL 3.5 data maintenance 
forms. 

Form Toolbar Controls 
The HomeRun XL 3.5 Form Toolbar provides controls that let you view and manage 
the data in the HomeRun XL 3.5 tables. 

HomeRun XL 3.5 toolbar controls let you navigate through the records, search for 
records, change the record order, add records, delete records and save changes to 
records. The control buttons have pictures, or icons, that represent their functions. 
The HomeRun XL 3.5 Form Toolbar controls are shown below. Note: Holding your 
mouse cursor over any toolbar buttons will display a description of these buttons. 

 

 

 
 

 

The next two pages provide brief descriptions of each Form Toolbar control. The 
Find, Locate, Filter, Order, and Group Delete controls are described in more detail in 
following sections. 

Editing Data 
When a form is activated in HomeRun XL 3.5, you may enter changes directly into 
the fields on the form. You click the Save button on the toolbar to save your changes. 
If you try to leave the current record without saving your changes, HomeRun XL 3.5 
prompts you to save your changes. 

Toggle Controls 
The Parent Mode and Filter buttons are toggles. As described in the table on the 
following pages, the pictures on these controls change to show whether the status of 
the control is On or Off. 

Parent Mode 

First

Previous

Next

Last

Find 

Locate 

Filter

Order

New

Copy

Delete 

Group  
Delete 

Save Close

CancelMoreOrder
Print
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Toolbar Menu Options 
The Edit and View menus contain options for each Form Toolbar control. Toolbar 
controls that change data are on the Edit menu. Toolbar controls that help you 
navigate among data are on the View menu. 

The Edit and View menus display shortcut keys you can use to select a Toolbar 
control instead of clicking it with your mouse. The shortcut keys are listed in the 
Using HomeRun XL 3.5 chapter. 

 
 

HomeRun XL 3.5  Toolbar Controls 

Picture Control Purpose 

 Record 
Selection 
Controls: 

The record selection controls allow you to choose the 
table records displayed and to set the display order. 

 
Filter - Off Brings up the HomeRun XL 3.5 Condition Builder for 

creating a record filter. When a filter is created, only 
records that satisfy the filter condition are displayed, 
and the Filter button toggles to the Filter On picture 
shown below. When the Filter Off picture is displayed, 
no record filter is in effect. 

 
Filter - On Turns filter off. When the Filter On picture is displayed, 

a record filter is in effect. 

 
Order Lists the table’s index tag descriptions for selecting the 

record display order. 

Navigation 
Controls: 

The navigation controls move through the records in a 
table and locate specific records.  As you navigate 
through the records in a table, the Order selected and 
the Filter in effect, if any, to determine how the table 
appears to the navigation controls. 

 
Find Brings up the Find dialog for finding a record using the 

table’s primary key or the current Order index key.  If a 
partial key is entered, all records matching the partial 
key are displayed in a Browse for user selection.  

 
Locate Brings up the Locate dialog for locating records using 

condition expressions created by the user.  Displays all 
records meeting the conditions in a Browse for user 
selection. 

 
List Provides a picklist grid with incremental search and 

sortable columns for finding records quickly and easily. 

 
First Displays the first record in a table as defined by the 

record Order and Filter. 

 
Prior Displays the previous record in a table as defined by the 

record Order and Filter. 

 
Next Displays the next record in a table as defined by the 

record Order and Filter. 

 
Last Displays the last record in a table as defined by the 

record Order and Filter. 
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HomeRun XL 3.5  Toolbar Controls 

Control Purpose 

 Data Update 
Controls: 

You use data update controls to maintain the data in a 
table.  As you update the data, a record of the update is 
entered in the Audit Trail if the Audit Trail tool is on. 

 

New Displays blank form fields for adding a record to a 
table. If the form is a child in a Related Forms group, 
the primary key fields in the parent record are 
automatically entered into the foreign key fields of the 
new child record. 

 
Copy Copies the current record and displays the copy for 

editing.  Used to add a record and carry values from 
the current record to the new record. 

 
Delete Deletes the current record from the table.  Relational 

Integrity is enforced. 

 

Group Delete Brings up the Group Delete dialog for deleting records 
using condition expressions created by the user.  
Deletes all records meeting the conditions entered.  As 
records are deleted, the Audit Trail is updated and 
Relational Integrity is enforced. 

 

More After entering a new record, clicking the More control 
saves the record and adds a new blank record. 

 
Save Saves data entered while adding, Copying or editing a 

record and ends the add or Copy. 

 
Cancel Cancels data entries and changes made while Adding, 

Copying or editing a record and terminates the Add or 
Copy. 

 Related 
Forms 
Controls: 

 

 
Parent Mode - 
Off 

Turns Parent Mode on for child forms. While Parent 
Mode is on, the record selection and navigation 
controls operate on parent records. When the Parent 
Mode - Off picture is displayed, Parent Mode is not in 
effect. 

 
Parent Mode - 
On 

Turns Parent Mode off.  While Parent Mode is off, the 
record selection and navigation controls operate on 
child records. When the Parent Mode - On picture is 
displayed, Parent Mode is in effect. 

 Close 
Control: 

 

 
Close Closes the form. 

Required Fields 
Some Fields on forms are designated as Required Fields and must be filled in before 
a record can be saved. These fields are shaded light yellow on the forms. Some of the 
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fields that are required are Enter Date on Bill of Sale 

 

HomeRun Condition Builder 
The HomeRun Condition Builder is an interface used with the Form Toolbar Locate, 
Filter and Group Delete controls and the Report Setup Dialogue’s For and While 
options.  

 
The Condition Builder allows you to construct simple and complex conditions to 
locate, filter or delete records on a form. The Condition Builder lets you create 
conditions to select the records that will appear in a report. 

Conditions Library: The Condition Builder allows you to store, maintain and 
recall a library of frequently used conditions for each form and report. What's more if 
you turn on User Access Security, each user can build her own library of conditions. 
In short, you can create condition libraries by form, report and user. 

How to Use the Condition Builder: The Condition Builder provides a list of 
fields for a form or report. You build a new condition by building condition 
statements from the fields provided. To build a condition statement, you select a field 
from the Condition Builder’s Field list, select an operator (such as, “equal to”, “less 
than”, etc.) that compares a value to the field, and enter the value for the comparison. 
The “How You Use the Condition Builder” section below provides step-by-step 
instructions for using the Condition Builder. 

How You Access the Condition Builder  
The HomeRun Condition Builder allows you to build a set of logical field conditions 
to be used to select records for a form or report. The way the conditions are used 
depends on how you access the Condition Builder, as follows: 

 Toolbar Locate: When you click the Form Toolbar Locate control, 
HomeRun displays the Condition Builder. After you build a condition and 
click OK, the condition you build is used to locate records that match the 
condition. If more than one record matches the condition, all matching 
records are displayed in a grid. If you select a record in the grid, the selected 
record becomes the current record on the form. 

Conditions 
Library List 

Condition 
Name 

Condition 
Statements 

Condition 
Statement 
Builder 
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 Toolbar Filter: When you click the Form Toolbar Filter control, 
HomeRun displays the Condition Builder. After you build a condition and 
click OK, the condition you build is used to apply a filter to the records 
displayed on the form. While the filter is in effect, only records that match 
the condition are displayed on the form. 

 Toolbar Group Delete: When you click the Form Toolbar Group Delete 
control, HomeRun displays the Condition Builder. After you build a 
condition and click OK, the condition you build is used to select the group 
of records to be deleted. Only records that match the condition are deleted. 

 Report Setup For Option: When you click the For check box on the 
Report Setup Dialogue, HomeRun displays the Condition Builder. After 
you build a condition and click OK, the condition you build is used to select 
the records displayed in the report. Only records that match the condition 
are displayed in the report. 

 Report Setup While Option: When you click the While check box on 
the Report Setup Dialogue, HomeRun displays the Condition Builder. After 
you build a condition and click OK, the condition you build is used to select 
the records displayed in the report. Records that match the condition are 
displayed in the report until the first non-matching record is found. When 
the first non-matching record is found, the report terminates. If the first 
record is non-matching, no records are displayed in the report. 

How You Use the Condition Builder  
You use the Condition Builder to create a “Condition”. A Condition is a set of 
logical Condition Statements that will be evaluated together as one expression to 
select records. 

The Condition Statements that you create for a Condition are listed in the Modify 
Condition box on the right side of the Condition Builder. A Condition consists of one 
or multiple Condition Statements. When a Condition is composed of more than one 
Condition Statement, the Condition Statements may be connected by an implicit 
logical AND operator or by an explicit logical OR operator. Condition Statements 
listed next to each other are assumed to be connected by an implicit AND operator. 
To connect Condition Statements by an OR operator, you must explicitly insert the 
OR operator by clicking the Add “Or” button below the Modify Condition box. The 
AND operator takes precedence over the OR operator. 

 

As an example, let’s say you needed to apply a filter to the Client and Contact form 
in HomeRun. Let’s say your filter needs to select Suppliers located in either 
Mississauga or Brampton. Here’s what the Condition Statements would look like in 
the Modify Condition box on the Condition Builder: 
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In plain English, these Condition Statements say “select a contact record (1) if the 
client type is Supplier and the client is located in the city equal to Mississauga or (2) 
the city is equal to Brampton. Notice that the AND operator is implied between 
Condition Statements that are not separated by the OR operator. 

Now, let’s explore the ins and outs of building Conditions. The next section 
describes how to use the Condition Builder in detail. 

 To use the Condition Builder  
1. When you select the Toolbar Locate, Filter and Group Delete controls and 

the Report Setup Dialogue’s For and While options, HomeRun displays the 
HomeRun Condition Builder. If you have not previously built and saved a 
condition, the Condition Builder looks like this:  

 
 The Condition Builder is divided into two columns. The left column lists 

the previously created and saved conditions in the condition library. The 
right column is used to build condition statements for a Condition. 

2. Starting and Naming a New Condition: To build a new condition, 
click the new condition button in the left-side Conditions column. If you 
want to save your new condition in the Conditions Library, enter a unique 
name for the condition in the Name box. If you like, enter a brief 
description of the purpose of the condition in the Comments box. 

3. Starting a New Condition Statement: Click the New Condition 
Statement button in the right-side Conditions Statement column. You can 
now access the Table, Field, Operator and Value boxes and the Condition 
Statements buttons to build a Condition Statement. The Condition Builder 
should now look something like this: 

New 
Condition 
Button 

New 
Condition 
Statement 
Button 

Condition 
Statement 
Buttons 
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 Notice that there’s already a Condition Statement in the Modify Condition 

box. It’s based on the first field in the Field list and the default Operator, 
which is “equal to”. When you build your first Condition Statements, it will 
replace the Condition Statements you see now. 

4. Select Table/View and Field: The next step in building a Condition 
Statement is to select the field for the statement. First, in the Table combo 
box, select the table that contains the field you want. Then, select the field 
in the Field combo box. The field you select will appear in the Condition 
Statement highlighted in the Modify Condition box. 

6. Select Operator: Select an operator in the Operator combo box. The 
operator defines how the field will be used with the value you enter into the 
Value box. The operator you select will appear in the Condition Statement 
highlighted in the Modify Condition box. The following operators are 
available to you: 

perator perator
not equal to  

less than  

greater than  

less than or equal to  

greater than or equal to  

equal to  

exactly equal to For Condition Statement to be true, Field 
and Value must not only be equal in value 
but must also be equal in length. 

in Enter comma-delimited list of values in 
Value box. For Condition Statement to be 
true, Field must contain one of the values in 
the list. 

contains Enter character string in Value box. 
Condition Statement is true if character 
string is contained anywhere within the 
Field. 
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7. Enter a Value: Enter the value in the Value box that will be compared to 
the Field you selected. Do not enter delimiters such as quotes or braces. The 
Condition Builder will add quotes and braces as needed. Enter dates in the 
Date format specified on the Environment Dialogue accessed from 
HomeRun’s Admin menu. By default a date should be entered in the 
mm/dd/yy format. The entry you make will appear in the Condition 
Statement highlighted in the Modify Condition box. 

8. Build Additional Condition Statements: If the Condition you are 
building requires additional Condition Statements, repeat steps 3 through 6 
above. If the next Condition Statement you create needs to be separated by 
the OR operator from the Condition Statement you just completed, click the 
Add “OR” button before clicking the New button to start the next Condition 
Statement. 

9. Adjust Condition Statements as Needed: If you need to change the 
order of the Condition Statements, select the Condition Statements you 
want to move and click the Move Up or Move Down button. If you need to 
add an OR operator, select the Condition Statement that the OR should 
follow and click the Add “OR” button. If you need to remove a Condition 
Statement, select the statement and click the Remove button. 

10. Apply and Save Your Condition: After you complete your set of 
Condition Statements, the Condition Builder should look something like 
this: 

 
 Click the OK button to apply your Condition. You will be prompted to save 

your Condition. If you save the Condition, it will appear in the Conditions 
list the next time you access the Condition Builder for the form or report. 
When the Condition Builder closes, your Condition will be used to select 
records for whichever Toolbar control or report option you selected to 
activate the Condition Builder. 

11. Using Conditions from the Conditions Library: When you access 
the Condition Builder for a form or report for which you have previously 
built and saved Conditions, you can apply a saved Condition by simply 
selecting it in the Conditions list and clicking OK. You can also select the 
Condition and modify it before you apply it. 

 
  

Condition 

Condition 
Statements 
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Find 
When a user clicks the Find Toolbar control, HomeRun displays the Find dialog. 

 

 

The Find dialog allows you to quickly find records for a table displayed on a form 
using either the table’s current order key or primary key. The fields in the current 
order key are displayed in the top half of the Find dialog. The field(s) in the primary 
key are displayed in the bottom half. You can enter values into either key field to 
Find a record. 

When you change the order of the records displayed on a form through the Order 
Toolbar control, the current order key fields are automatically changed the next time 
the Find dialog is displayed. 

Use Match Case for a Faster Search 
The Find dialog contains a Match Case check box that will cause the Find to perform 
a case-sensitive search for character fields.  The case-sensitive search is much faster. 
However, to do a case-sensitive search, you need to know how the entries in the field 
you are searching are capitalized. 

How the Find Control Finds Records 
Partial Entries: The Find control finds records that match whatever characters you 
enter into the current order key or primary key fields. For example, using the Find 
dialog illustrated above, a partial entry of “B” in the Last Name field would find all 
records with a Last Name that began with “B”. 

Key Precedence: The Find control gives precedence to entries for the primary 
key. That is, if you make entries on the Find dialog for both the current order key and 
the primary key, the Find will find records that match the primary key entry. If no 
records match the primary key entry, the Find will find records, if any, that match the 
current index key entry. 

Find Grid: If more than one record meets the search criteria entered, HomeRun 
displays all the records that meet the search criteria in a searchable, sortable grid. 
You can highlight a record and close the grid to display the record on the form. 
Using the Find dialog illustrated above, if an entry of “B” were made in the Last 
Name field, HomeRun would display the grid below. 



44    Data Entry HomeRun XL 3.5 Car Dealer Software 

 

Locate 
When you click the Locate toolbar control HomeRun displays the HomeRun 
Condition Builder. 

 
The Locate Condition Builder allows you to find records using any fields in the Field 
list for the tables in the Table list. 

See “HomeRun Condition Builder” on page 38 to learn how to use the Condition 
Builder with the Locate control. 

Locate Grid: If more than one record meets the search criteria entered, HomeRun 
displays all the records that meet the search criteria in a searchable, sortable grid. 
You can highlight a record and close the grid to display the record on the form.  
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Filter 
When you click the Filter toolbar control, HomeRun displays the HomeRun 
Condition Builder. 

 
The Filter Condition Builder allows you to filter records using any fields in the Field 
list for the tables in the Table list. 

See “HomeRun Condition Builder” on page 38 to learn how to use the Condition 
Builder with the Filter control. 

When you complete building a Condition, clicking the OK button sets the filter on 
the active table or view.  From that point, only records that meet the filter condition 
are displayed on the form. 
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Order 
When you click the Order Toolbar control, HomeRun displays the Order dialog. 

 
The Order dialog displays the record orders you can select for the table displayed on 
a form. The current order is highlighted. You change the order of the records on the 
form by selecting a different order. The order can be made ascending or descending 
through the option buttons on the Order dialog. 

Group Delete 
When you click the Group Delete toolbar control, HomeRun displays the HomeRun 
Condition Builder. 

 
The Group Delete Condition Builder allows you to conditionally delete groups of 
records using any fields in the Field list for the tables in the Table list. 

See “HomeRun Condition Builder” on page 38 to learn how to use the Condition 
Builder with the Group Delete control. 
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When you complete building a Condition, clicking the OK button executes the group 
delete. While HomeRun performs the group delete, it enforces referential integrity 
and maintains the audit trail. Consequently, the group delete process can seem slow 
if the active table or view is involved in a referential integrity relationship. As 
records are deleted, the number of records deleted appears in a wait window. 

Tip: Pressing the Esc key terminates the group delete. 
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Client & Contacts 
This is where you enter and manage all your Clients and Contacts. 

When you click on the Menu Item, you will be offered a List Form. This allows you 
a quick way to find a particular or group of records. 

 

 

 
As you add more records, you will be presented with a larger list of all the records in 
the data table that match your request. Click on the label on the top of the column 
and type the start of the name you are searching for. If you were looking for LeBlanc 
& Associates, you could type the letter “L” and you will be taken to the beginning of 
the names that start with “L”. Type the next letter “e” and so on to find your record. 
The Index order is incremental which allows you to quickly find the record you’re 
looking for. 

If you want to search for a record by a different field shown, Click on the field name 
at the top of that column. That field will become the active search field. Type the 
first few letter of name you want to find. 



 

HomeRun XL 3.5 Car Dealer Software Data Entry    49 

The Form is divided in 3 sections. 

Main Information 

 
The first one is for the “Main Information about the contact. 

This is the part where you put all the main information about the contact 

Note that the Down Arrorw  next to a field denotes that you can pick a value from 
a pick list for this field. This allows you to enter constant values in that particular 
field without typing them in. You can also press F2 while your cursor is on this field, 
or, click the Right Mouse button to choose from a pick list. 

If the record is a Company Record, check the Company Record. If this is a record for 
an individual, leave this field blank. This is used by the program when entering a 
“Retail Bill of Sale” to differentiate between a sale made to an individual or a 
company. 

When entering a new Client, you can enter the Salesperson that either generated the 
lead or has been assigned to them. You access the Salesperson table by first clicking 

on the drop down button next to the Salesperson Field  and picking a salesperson 
from the list. If the name of the Salesperson is not in the Table, you can enter a new 
one by choosing Add from the button on the Picklist. 

Next Choose Contact Type from the type field. This is how you will sort your 
contacts in the future. You can add or modify the Contact Type Labels to suit your 
particular business needs. 

Enter the balance of the Contact or Client information. You will notice that the City 
and Province also have an F2 Picklist to help you with your choice and to eliminate 
as much typing as possible. 
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You will also notice the name is displayed at the very top of the form. That is so that 
you will always know which Contact you’re working with, no matter what tab you 
are in. 

When you enter a new record, the Active Field is ticked on. When a Contact becomes 
inactive, for whatever reason, you can uncheck this field and still keep the 
information in the Table for future reference. Then, when you print a contact list, you 
can choose to print only the Active Contacts. 

The bottom area of the form displays vehicle summary information for all vehicles 
purchased from, sold to or traded by the current contact. This includes all Wholesale 
or Retail activity. Pressing the “Print Vehicle History” will allow you to view and 
print the history. 

 
The Status Shown for the Transaction Type are as follows. 

Transaction Type Menu Legend 
Legend  Purpose 

RB  Sold through Retail Bill of Sale. 

TR  Vehicle Taken in as Trade through Retail Bill of Sale. 

WB  Vehicle purchased through the Wholesale Buy 

WS  Vehicle Sold through the Wholesale Sell. 

 

Miscellaneous Information 
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For a Retail Contact, you will enter the drivers licence and insurance information. If 
you do not enter this information here, you can choose Edit from the picklist menu in 
the Retail Bill of Sale to enter it then. It will then be copied back to the Sale form. In 
the case of Dealer, you must enter the Dealer’s information here. It is taken from 
here when entering vehicles in the Bulk Purchase, Wholesale Buy and Sell forms. 

You can also enter any miscellaneous information you wish to make about this 
record in the notes or memo field. 

 Dealer Information 
When you either Buy or Sell a Vehicle to another Dealer, you’re required to keep 
track of certain information. This information should be entered on this tab. In this 
way, when you fill out the Buy or Sell information, the information will 
automatically be entered on those forms and you will have a permanent record of the 
complete transaction. 

 Licence and Insurance 
In the case of a Retail Client, you require certain information when filling out a Bill 
of Sale. When you have previously sold a particular Client a Vehicle, you would 
already have some of this information. In this case, the information would 
automatically be filled in when you make out the Bill of Sale form. You can then 
update the information as required. When you save the Client Information in the Bill 
of Sale form, the information from this tab automatically gets updated to the most 
current information. 

In the case of a Dealer, filling in the RIN # field will ensure that the correct 
information is entered in the Wholesale Buy/Sell form when required. 

Correspondence 
This page tab will allow you to enter email or web information for a Contact. 

 
On this Page, you can keep the email or web address for this Contact. 

You can also send an email to a particular contact. This process will use your current 
email client provided you use a MAPI compliant email program. i.e. Outlook or 
Outlook Express. 

This page tab is also where you store the default basic information regarding the 
Floor Plan for a particular finance institution. Then when you pick the floor plan 
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company to use in the Vehicle Information screen, the program will copy this 
information to the form. It can be modified, if required, for a different floor plan. 

 

Print Contact Information 
You can print Contact information for the record shown on the screen by clicking the 
“Print This Record” button on the bottom of the form. This will bring up the 
selection form. 

 
Choose whether to print just the basic information or to print personal information of 
contact. 

 

 
Basic Contact Report 
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Personal Information Contact Report 

 

 
Vehicle Info for this Contact 
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Vehicle Information 
From this screen, you will manage your Vehicle Inventory. All Vehicle history as 
well as current inventory is kept in this Table. This allows for data access and report 
production for all vehicles that passed through your Dealership. 

 
This Form is broken into 6 tabs, each holding related information.  

Vehicle Information 
This screen holds the main vehicle information. The program automatically assigns a 
new Stock Number for all new vehicles added. 

 
Enter the Asking Price in the Ask Price field. This information will be used when 
doing up Bills of Sale.  Fill out the Status field from the F2 PickList.  

(See Status Information below for description of this field)  

Choose items from the Picklist for Make, Model and Colour fields 

When you enter a Serial/VIN, HomeRun check the VIN to see if the number entered 
is a valid Serial Number. If the number is incorrectly entered, a message is displayed 
informing you of this and allowing you to change or re-enter the VIN.  

 
This function also checks that the year entered matches the 10th position validity 
check. If the year is incorrectly entered, HomeRun will change the year 
automatically to match the correct year for the VIN. 

 

 
  



 

HomeRun XL 3.5 Car Dealer Software Data Entry    55 

Status Field Menu Legend 
Legend Description Purpose 

A Available Means that the particular vehicle is on the lot and 
available for sale. 

P Purchased When a vehicle is added to the Inventory through 
the Wholesale Purchase form it is marked as with a 
“P”. In this way, you can go in to add the 
additional information and get the car ready for 
sale. Once available for sale, the Status field 
should be changed to “A” 

R Returned This vehicle was added to Inventory but was 
returned to the Originating source. 

S Sold This vehicle was sold Retail. 

T Trade-in This vehicle was taken as a trade-in. 

W Wholesale This Vehicle was sold Wholesale to another Dealer 

You can add additional items to this list by selecting the Status Item from the support 
table menu item on the Data -> Lookup Tables -> Status from the main menu. 

Purchasing Information 
On this tab, you will have information on whom you acquired the Vehicle from. If 
you acquired this particular Vehicle as a trade-in, the vehicle will be added to the 
table from the Bill of Sale screen and will be marked with Status of “T”. The 
purchasing information will automatically be entered on this screen from the Bill of 
Sale form.  If the Vehicle was purchased Wholesale and entered via the Bulk 
Purchase or Wholesale Buy Form, the information will be filled in automatically 
from the this form and that particular vehicle will be marked with a status of “P”. 

Note: You should go in after receiving vehicles from trade or bulk/wholesale 
purchase and complete the selling price and change the status as Available. 

 

 
Note that the Bought From fields are “Read Only” on this form. The purpose of these 
fields being Read Only is that the information has to be picked from the Contact 
Table to ensure that the information in this table is always up to date. If the Bought 
From contact is not in the table, pressing “Add” will bring up the contact form which 
will allow you to add the contact to the table. If you notice after picking the Contact 
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that the information is incorrect, press the F2 Picklist icon again and click “Edit” and 
correct and save the information in the contact form. Note: You may have to pick the 
contact again after returning to this form to refresh the information. 

Mileage 
This tab will show the Date the Vehicle was acquired. If the vehicle was purchase 
through the Wholesale Purchase module, the Date In, Miles and Cost will 
automatically be entered from the data captured in the Purchase module. 

Once the vehicle has been sold (either through the Bill of Sale or Sell Wholesale 
module) the Date Out, Sold Price, Miles Out and DOT# out will be automatically 
filled in where appropriate. 

Miscellaneous notes about this Vehicle can be entered in the 2 Notes field. 

 
 

 

 

Notes and Comments 
 

In this section you write out the Description that will be used in your Current Vehicle 
Listing. 

The Memo field is a general memo field to put miscellaneous information about this 
vehicle that doesn’t belong elsewhere. 
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Sold To 
This tab is to hold the Sold To information. It is filled in automatically when you 
update sold information when doing either a Wholesale or Retail Bill of Sale. 

 
 

Costs 
This tab holds all the pertinent costs and selling prices on this particular vehicle. 
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View Expense Details 
At any time, you can view or print expense items that make up the repair or 
miscellaneous cost by clicking on the “View/Print Expense Detail”. 

You can print the total expense for this particular vehicle by clicking on the “Print 
Expense” Button 

 

Recalculate Button 
Pressing this button will recheck the costs and recalculate the totals on this tab. 

Floor Plan  
The floor plan detail information is included on this Tab. 

Pick the Floor Plan Information from the F2 Pick List for the Floor Plan company. 
The Finance Rate and other information will be copied to this vehicle from the 
finance rate and other information entered in the Contact Table. 

Once the Finance Total amount is set, check the box to lock the Total Cost 
Calculation. This can be unchecked in the future if there is a need to reset this 
information. 

Enter Repair Expense 
This is where you will enter all expenses other than the acquisition cost. The Vehicle 
must already have been entered to enter expenses. 

 
If you want to view or modify a particular expense for a vehicle, fill in the 
information on the Find form. To enter a new expense, click Cancel and click the 
Add button on the Button Bar. 
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Choose the Stock # from the F2 PickList. Once chosen, click Save and the Make, 
Model and Year fields will be filled in. 

Choose the Company from the Company F2 Picklist Icon. After choosing the 
company, click save to fill in the balance of the company fields. If the Company is 
not entered in your Records or if some of the information entered is not correct, you 
can Add or Edit a company from the F2 Picklist screen. 

Continue filling in the Date, Invoice # and enter a short description of the work 
covered by this invoice. You can use the F2 from the Description field to pick an 
item. 

Enter the Invoice Amount less the GST/HST/HST in the first field. Enter the 
GST/HST and Total amounts in the appropriate fields. 

(You should note that for costing purposes, your invoice amount should include all 
labour, materials less GST/HST.) 

When you save each Vehicle Expense record, the particular vehicle’s Expense totals 
is automatically recalculated and updated. 

Tip: If you entered an incorrect amount for a particular expense, simply find that 
entry and make the correction. When you save that particular expense, the vehicle 
expense summary on the Vehicle Info Form will be automatically recalculated. 
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Bill of Sale – Retail 

Bill of Sale 
 

The Bill of Sale screen is comprised of 8 tabs each displaying related information. 
The process is as follows: 

 

1. Fill out the first 7 pages in order. The 8th page displayes cost and profit 
information pertaining to this Bill of Sale. 

2. Print the Bill of Sale for the Client to Sign. 

3. Place the Bill of Sale in your printer again and Click the “Print Condition 
Information” button to print the Conditions on the back of the Bill of Sale. 

4. After the deal has closed, Click the “Update Car Status Information” button to 
update the Car Info Table with the sold to information. 

5. After the deal has closed, Click the “Sold to Information” button to update the 
information for this client in the Client Table. 

6. If expenses have been added to this vehicle after the Bill of Sale screen is saved, 
update the information in the Car Info Table by clicking on the “Update Cost 
Info After Sale Complete” buttom on the info tab. 

Vehicle 
Choose a vehicle from the Stock # F2 PickList. Once chosen, the relevant 
information from the Car Info Table will be entered in the appropriate fields. 

Enter the Sold and Delivery Dates, and current vehicle mileage. Choose KM or 
Miles from the KM PickList as appropriate. Check the Safety Cert and Emission 
Certificate checkboxes and enter the Safety Certificate Numbers. (can be entered 
later but must be filled in before the Bill of Sale is printed or it will have to be 
manually entered on the Bill of Sale.) 
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Note : If you wish a comment to print on the Bill of Sale, type whatever you wish 
printed in the Comment Field. 

Trade-in Vehicle 
Enter the Trade-in vehicle information on this tab including Owner information if the 
Owner of the Vehicle is different than the information entered in the “Sold To” 
Screen 

 

 

Tip: If after having entered the Trade Vehicle and adding the trade vehicle to 
inventory the Client decides to not proceed with the Trade,Press the “Delete Trade 
Vehicle” button and the trade will be deleted from this Bill of Sale and Deleted from 
your Inventory. 

 

 

Sold To Information 
 

Choose the Sold To information from the F2 PickList icon next to the Person field. If 
the person is not already in the Contact Information table, click the Add button to go 
the Contact Information entry screen. Fill in all the information on this Client 
including the Insurance Information. It is recommended that even if the Client is 
already in the Contact Information table, that you click the Edit Button and confirm 
with the Client that the Insurance information is entered and correct. 

Save the record and exit the Contact Information screen. When you return, the main 
information will be entered on the” Sold To” screen. Save the record at this time.  

All the relevant information on the Client, including the Insurance information will 
automatically be entered on this form. 

If the Purchaser is a Company rather than an Individual, Check the “Sold to 
Company?” checkbox. This way, the Company name will be printed on the Bill of 
Sale. Otherwise, the First and Last Name of the Purchaser will be printed. 

 



62    Data Entry HomeRun XL 3.5 Car Dealer Software 

 
 

Insurance 
The information on this tab should already have been entered from the Client 
Information table. If not, return to the Sold To tab and rechose the contact again and 
enter the information in the insurance tab of the Contact form. Once you save the 
data and close the Contact form, the information will then be filled in here. 

 

 
 

Salesperson 
Choose the Salesperson Information from the F2 PickList. The Salesperson 
Registration number will be automatically filled in when you choose the 
Salesperson. 

Then, Choose the Accepted by PickList to choose the person responsible for 
accepting the offer for the Dealership. The person’s position and Registration 
number will automatically be filled in. 
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Warranty 
There are 2 types of Warranty that a dealer can give, a Dealer Warranty and a 3rd 
Party Warranty. In both instances, there can be many different warranties that would 
be applicable for a sale depending on the year and type of vehicle etc… sold. 

These Warranties should be entered in the Warranty Table. (Data ->Lookup Tables-
>Warranty menu item to administer these items.) 

If there is a Dealer Warranty with this vehicle sale, check the Dealer Warranty 
checkbox and choose the F2 PickList tab next to months to choose a previously 
entered warranty detail. Modify the description if required to reflect the exact nature 
of the warranty given. 

If there is a 3rd Party Warranty, check the checkbox and choose the previously 
entered warranty detail from the Company F2 PickList button. 
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Price 
The Price will be automatically filled in with the Ask Price from the Car Info table 
when you choose the car in the Vehicle screen. Modify this price if required. 
Continue filling in the tabs in order. 

Provision has been made so that description and price for 3 miscellaneous items can 
be entered. The short description entered will be printed on the Bill of Sale. 

The program automatically performs calculations. After filling in the items on the 1st 
column, click the Save button to update the calculations. 

Continue filling in the information on the right side of the screen. After filling in the 
Deposit and Paid By fields, click the Save button again to update the calculations. 

If the vehicle is to be financed, fill in the Financing information. 

If you fill in the number of payment Payment Start Date , and the Finance Rate and 
click the “Calculate Loan Payment” button, it will fill in the Amount of Payment, 
and the Cost of Borrowing using the Net Amount Financed total. 

 

 
Click the Loan Calculator button to calculate the loan amount details. Ensure that 
the Pay Frequency, Net Amount Finance, Interest Rate and Number of Payment are 
correct.  

Press the Calculate Amount Button. Then Press the Copy to Bill of Sale Button and 
then the Close Button. The amounts will be copied back to the Bill of Sale Pricing 
Tab and the totals recalculated. 
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After the information on this screen has been completed, Click the print button on 
tab 9 of the form to print this Vehicle Bill of Sale. 

 

 

Info & Costs 
 

You can make general notations on this particular sale in the Notes fields. 

When you save the information on the price screen, the profit is automatically 
updated on this screen. 

Note: Since Costing and Profit information is on this screen, do not click on this tab 
if the Client is in a position to see it. This screen is basically designed as a check to 
ensure that this particular sale is profitable.  

Management can check this tab either during the sales process or before the deal is 
signed to ensure that this particular sale is profitable and what the gross profit 
amount after expenses is. 
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This graphic shows the last tab with a description of “Notes & Cost”.  In the actual 
program, this tab is blank so that if anyone is looking over your shoulder while you 
are filling in a Bill of Sale, they will not know this tab exist. If you do not want 
someone to see the data on this sheet, do not click on the top tab. 

Note : In order to be able to have data when printing the Sales Report from the 
“Report” menu item, you need to Click the Update Cost button. 

The data for the report is taken from the Retail Bill of Sale Table. 

 

Print & Update 
 

 
 

The top 3 horizontal buttons are to be used after the sale is completed,  

1 Add Trade to Stock – This will add the trade vehicle to your inventory. The 
program will add the next vehicle stock number to the vehicle. So you can find 
the vehicle in the data file, the status will be marked as “T” for trade.  The 
program will also update the Vehicle History Table with the trade information. 

2 Update Car Status Information – This will mark the status for the Sold vehicle 
as sold in the vehicle table. 

3 Update Sold To Information – This will add the information on the purchaser of 
the vehicle in the Sold vehicle record. The program will also update the sell 
price for this vehicle and recalculate the profit based on the information in the 
record. This will also update the Vehicle History Table with the Sold vehicle 
information. 

The following 6 buttons are for the printing of the Retail Bill of Sale as well as other 
functions that are required for a sale. 

Click these 
tabs only after 
the Bill of Sale 
is Completed 
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1. Print Bill of Sale(Duplex) – With more duplex printers in the marketplace, it is 
now possible to print both front & back pages of a report in 1 pass. If you’re 
printer supports duplex printing, this will make it easier to print. 

2. Print Bill of Sale – Front – If you do not have duplex printer, you will have to 
print the front & back of the Bill of Sale individually. 

3. Print Bill of Sale – Back – After printing the front of the bill of sale, turn the 
paper around and print the back of the Bill of Sale. 

4. Print receipts for Deposit -  Some Purchasers ask for a separate receipt for their 
downpayment. At the request of some of our clients, we have included this 
option in the program. 

5. Print Trade-in Information Form – The new Ontario regulations require a 
Purchaser to give the Dealer additional information on the trade vehicle. This 
form will fill in the Name & Address of the Purchaser as well as the information 
on the Trade Vehicle as entered in the Retail Bill of Sale. There is a data section 
on the form that states that this information “Can only be filled in by the 
Purchaser of the Trade Vehicle”  Have your Purchaser fill in an sign the 
information. 

6. Run Vehicle Appraisal form PDF – This button opens the Ministry of Finance 
Appraisal form. You can then fill in the form on screen in a legible manner and 
print the form. This form cannot be saved. You can also access this same form 
from the Main Menu. 
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Retail Bill of Sale – Front Page 
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Retail Bill of Sale – Back Page 
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Trade-In Information Form 
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Purchase Bulk Vehicles 

Purchase Bulk Vehicles 
Whether you buy your vehicles individually or in bulk, this section will allow you to 
enter the car information and print a list of the vehicles purchased. 

For entering new purchases, the steps are as follows, 

1. Choose the Vendor from the F2 PickList next to Vendor Name. 

2. Verify the Vendor Licence and other information from the Number Tab. 

3. Enter the Purchasing Salesperson information. 

4. Enter the vehicles in the Cars Purchased grid. Note that you do not assign the 
Stock number at this time. 

5. Click the Update Car Stock button on the top right corner of the screen. 

6. Print the List. 

 

 
Check the information is correct. If there is no information shown, go back to 
Vendor Address tab and choose the Vendor PickList Icon and click the Edit button.  
This will put you in the Contact Form. Ensure that the information is entered 
correctly for this Vendor. Save and Close the Client Form and return to the 
Agreement. Save the information again. The information will be transferred to this 
form. 

Choose Purchaser Salesperson from the Purchaser Salesperson PickList Icon. 
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Enter the information on the Cars Purchased. You can put in as many vehicles in the 
grid as you wish. 

Fill in the Vend Stock #, and Year. When the cursor is in the Make field, Press F2 to 
choose a vehicle make from a list. Do the same for the Model field. 

Fill in the Serial #, Mileage and Price Paid fields. Also if the vehicle is either a 
Police Car or Taxi, check the P/T Checkbox. 

Note that the Serial Number is checked for validity when you move off the Field. If 
the Serial Number is entered incorrectly, you will be prompted to reenter it correctly. 
Also, the year is extracted from the Serial Number and put in the Year field for that 
particular vehicle. 

 
The entering of an incorrect VIN will not stop you from continuing entering 
information. This feature is intended only to alert you of an incorrect VIN. 

 

A running total at the top of the screen will update after you save each vehicle. 

 

 
 

Update Car Stock 
Once you finish filling and saving the Vehicle information, click the Update Car 
Stock button. This will assign a Stock Number to each vehicle and add them to the 
Vehicle Info Table with a Status of  “P” for Purchased.  It will also update who the 
Vehicles were purchased from. 

You can then go into the Vehicle Info screen and update Asking price information. 
When the vehicle is ready for sale, change the Status to “A”. 

 

Click the Print Icon to view and print the Wholesale Purchase Agreement. 
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Wholesale Buy/Sell Agreements 

Wholesale Buy Agreement 
The new MVDA Regulations has specific requirements on Dealers when Buying and 
Selling used vehicles. 

HomeRun XL 3.5 has been designed to allow Dealers to enter vehicles while 
capturing the required informationa dn printing compliant Bills of Sale. 

In the greatest majority of the cases, vehicles are purchased one at a time. Because of 
the information that has to be entered for each vehicle, the agreement has been 
designed to be entered one vehicle at a time. 

The steps for filling in the Wholesale Buy Agreement are as follows. Note that the 
form has 2 tabs. The first tab contains the purchaser and vendor information as well 
as the basic vehicle information. The second tab has the Vehicle disclosure 
information. 

NOTE: There are times when a Dealer purchases a vehicle from an private 
individual. When this is the case, if the Company Name in the Contact table is 
empty, the program will enters the First and Last Name of the Contact record in the 
“Seller Name” field. Otherwise, the Company Name will be entered. In the case 
where the Seller not a HST Registrant, Check the box “HST/GST Exempt” and the 
tax will not be calculated. 

1. Choose the Vendor from the F2 PickList button next to the Vendor Name. 

2. Verify the Vendor licence and other information from the Number tab. 

3. Enter the Purchasing Salesperson information. 

4. Notice that the Purchaser Name and other information is automatically 
filled in when you enter a new record. 

5. Enter the name and licence number of the person that will be signing the 
document for this vehicle purchase. 

6. Enter the information for the vehicle purchased on the bottom part of the 
form. Note that you do not assign the Stock Number at this time. A stock 
number will be assigned for this vehicle when you press the Add Vehicle to 
car stock button. 

7. Click the “Check & Disclosure Statement” tab and fill  the information. 

8. Click on the Update Car Stock button at the top right corner of the form. 

9. Print the Wholesale Buy Agreement. 
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Wholesale Sell Agreement 
You will use this section to sell Vehicles to other Dealers or Wholesalers. 

In the greatest majority of the cases, vehicles are purchased one at a time. Because of 
the information that has to be entered for each vehicle the agreement has been 
designed to enter only one vehicle at a time.  

The steps for filling in the Wholesale Buy Agreement are as follows. Note that the 
form has 2 tabs. The first tab contains the purchaser and vendor information as well 
as the basic vehicle information for the Vehicle Sofd. The second tab has the Vehicle 
disclosure information. 

You will notice that the information on you the Seller is automatically filled in on a 
new sale. Enter the Salesperson and their MVDA registration number.  

Choose the Vendor from the F2 PickList next to Vendor Name.  

Verify the Vendor Licence and other information from the Number Tab.  

Enter the Purchasing Salesperson information.   

Choose the Vehicle by picking it from your Vehicle Inventory.   
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If the VIN is incorrect, the message will indicate this. 

                
If you want to copy the VIN to another Windows program, simply click the Copy 
button and the VIN as entered will be copied to the Windows Clipboard. You can 
then simply paste it in your other document etc… 

 

Check Duplicate VIN 
 

Let’s say that you sold a vehicle to a Client. The Client was so happy with his 
purchase and the service received that he returns to buy or trade for another vehicle. 

You want to check the information on what will now be his trade vehicle. Simply 
enter the VIN in this form and program will give you the original stock number of 
this vehicle. 
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Administrative Tools 

Overview 
This chapter describes the HomeRun XL 3.5 administrative tools that aren’t 
described elsewhere in this User’s Guide.  This includes: 

 Error Handling: See “Errors” on page 83. 

 Reindex / Pack Tables Utility: See Reindex / Pack Tables Utility. 

Admin Tools 

Errors 
Regardless of how extensively a developer tests software, errors occur. 
Consequently, HomeRun XL 3.5 contains an error-handler that deals with errors 
gracefully and records useful information about the errors. 

Important: Don’t be alarmed. We do not expect that you will encounter many, if 
any, errors while running HomeRun XL 3.5 However, if you do encounter an error, 
we want you to know that HomeRun XL 3.5 has the ability to handle it and to help 
resolve it. 

If an error occurs, the error-handler determines the severity of the error and handles 
it accordingly. Information about an error is recorded in an errors table, which is 
displayed on the Errors form. You can reach the Errors form from the Admin menu 
Errors option.  

 
You use the information on the Errors form to resolve errors and to report them to 
the LeBlanc & Associates 
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When the Errors form first appears, it shows information for the last error that 
occurred for the current user. The errors are shown in descending order of the time 
and date the errors occurred.   

You can: 

 Order: Change the order to ascending through the Order button on the 
Errors form. 

 All Users: If you’ve implemented User Access Security in HomeRun XL 
3.5, you can view errors for all users who have run HomeRun XL 3.5 by 
clicking the All Users option button in the Filter box. 

 All Apps: If HomeRun XL 3.5 is sharing its error file with another 
LeBlanc & Associates application, you can view errors for all applications 
by clicking the All Apps option button in the Filter box. 

 Form Controls: You cannot edit or add error records but you can delete 
them. 

 Memory: Click the Memory button to see the contents of memory 
variables and arrays when the error occurred. 

 Status: Click the Status button to see the status of the FoxPro environment 
when the error occurred. 

The following table explains the fields on the Errors dialog. 

Errors Fields Contents 

User ID Blank if User Access Security is not on in HomeRun 
XL 3.5; otherwise, contains the ID of the user who 
experienced the error. 

App Prefix 3-character prefix of the application that produced the 
error. 

Error # FoxPro error number. 

Date/Time Date and time the error occurred. 

Message FoxPro error message. 

Program Program routine running when the error occurred. 

Code Code line that produced the error. 

Line # Number of code line that produced the error. 

GET Field Name of GET field, if any, cursor was on when error 
occurred. 

Last Key Last key pressed before error. 

Top Window Topmost window, if any, when error occurred. 

Errors Report 
The HomeRun XL 3.5 Report Manager contains an errors report. The errors report 
prints error records in the errors table. You can select the report’s order, filter and 
scope. 

Errors Management 
Periodically, backup the errors table and delete its records. You can use the Group 
Delete on the Errors form. 
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Reindex / Pack Tables Utility 
HomeRun XL 3.5 contains a Reindex / Pack Tables utility on HomeRun XL 3.5's 
File menu. This utility allows you to recreate indexes if they become corrupt. You 
can also use the utility to pack tables to remove any records marked for deletion and 
to pack memo fields.  

 

 To use the Reindex / Pack Tables Utility 
1. Click either the Reindex or the Pack option button. If you select Pack, 

HomeRun XL 3.5 will also reindex the tables you select. 

2. The Tables list on the left side of the dialog shows all the tables in 
HomeRun XL 3.5, including system tables. You select the Tables you want 
to reindex or pack. When you select a table, the Selected Tables list on the 
right side of the dialog displays the table's name. 

3. You can select: 

 A table individually by highlighting it in the Tables list and double-
clicking it or clicking the right-arrow button.   

 All tables by clicking the double-right-arrow button.   

 All non-system HomeRun XL 3.5 tables by clicking the Application 
button. HomeRun XL 3.5 identifies non-system tables as the tables 
whose names do not begin with "S". 

 All system tables by clicking the System button. HomeRun XL 3.5 
identifies system tables as the tables whose names begin with "S". 

System Tables: System tables are tables that contain data used by standard 
HomeRun XL 3.5 functions such as the data dictionary, audit trail, error handler, etc. 
Non-system tables are tables that contain your data files. 

4. You can remove tables from the Selected Tables list by: 

 Highlighting an individual table and double-clicking it or clicking the 
left-arrow button. 

 Clicking the double-left-arrow button.  HomeRun XL 3.5 will remove 
all tables from the Selected Tables list. 

5. When you have selected the tables you want, click OK and the reindex or 
pack operation begin. 
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Security 

Overview 
Users of professional business database applications expect extensive security 
features in the applications they use. They expect User Access Security, Access 
Levels Security, Menu Security, Controls Security and Field Security. Fortunately 
for you, HomeRun includes those security features. 

This chapter describes the HomeRun security features by showing how to turn on 
and set up security for application users. 

Implementing Security for Users: The following sections of this chapter 
describe how to turn on and set up security for application users: 

 Turning On Security: See “Turning on Security page 86.   

 User Access Security: See “User Access Security” on page 89. 

 Access Levels Security: See “Access Levels Security” on page 94. 

 Menu Security: See “Menu Security” on page 95. 

 Controls Security: See “Controls Security” on page 98. 

 Field Security: See “Field Security” on page 101. 

 User Security Mistakes and How to Recover: “User Security 
Mistakes and How to Recover” on page 104. 

Turning on Security 
You turn on User Access Security, Controls Security, Field Security and Menu 
Security on the Admin Tools dialog. You reach the Admin Tools dialog from your 
application’s Admin – Security menu. 

 
A check in a Security check box on the Admin Tools dialog turns a Security tool on. 
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Caution: Do not turn on security until you know how HomeRun security works and 
how to set it up. If you can’t wait until you’ve read this chapter to turn on security 
and you wind up locking yourself out of HomeRun, see “User Security Mistakes and 
How to Recover” on page 104. Then, vow to read thischapter before you turn on 
security again. 

By Default, groups of users have been set up within HomeRun security. The Groups 
that have been set up are as follow: 

 DEV: This group is reserved for the HomeRun staff to be used in case you 
should lock yourself out of the program. This Group is set up to have 
Access Security Level of “A”. 

 MGR: This group is for the Administrator, Owner or Manager. It gives you 
full Management Permission to all fields, controls, tables. This Group 
should be set up to have Access Security Level of “B”. An initial user is set 
up in HomeRun by default. We will give you this User Name & Password 
when you purchase the program. All other users have to be set up by you. 

 SMG: This group is for the Senior Managers. It has been modified from the 
MGR group to not allow as many features as given to the manager level. 
You can add or not allow control to features in the program when you allow 
this level for individual users. This Group should be set up to have Access 
Security Level of “C” 

 US1: This group is one of 2 groups set up for day to day users. This group 
will not allow permission to some groups or Menu items, but will allow to 
see cost on the Bills of Sale & Vehicle Info form. This Group should be set 
up to have Access Security Level of “D”. 

 US2: This group is for the lowest group of Users. This level will not allow 
this User to see any costs. Will also not be able to run any security or cost 
reports. This Group should be set up to have Access Security Level of “E” 

 

User Access Security Must Be On: When User Access Security is off, Controls 
Security, Field Security and Menu Security are off even if they are checked on the 
Admin Tools dialog. A user must log into an application with a User ID and a 
Password before Controls, Field and Menu Security can function. 

Access Levels Security: You turn on Access Levels Security by entering an “B” 
in the first character of the Status field for a user on the Users form. See “Access 
Levels Security” on page 94. If you are the system supervisor, make sure that the 
first user for whom you enter a “B” is you. The “A” is for the Developer. This allows 
us to be able to access your system if you should lock yourself out by mistake. Tip: 
Access Levels Security is not turned off when User Access Security is off. This adds 
another layer of protection to HomeRun security.  

Password Access Security: You turn on Password Access Security by checking 
the Access check box on the Passwords form. If you are the system supervisor, make 
sure that the first user for whom you check the Access check box is you. Tip: 
Password Access Security is not turned off when User Access Security is off. This 
adds another layer of protection to HomeRun security. 
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Setting Up the System Supervisor 
The first user entered on the Security Users form is normally the system supervisor, 
the person who is responsible for setting up HomeRun security. The first user should 
be given the highest level of security permissions. Here’s a checklist of what you 
need to do to set up the system supervisor, or first user, before you turn security on: 

 Users Form: Add a record for the system supervisor on the Users form. 
You will need a User ID and Temporary Password for the system 
supervisor. See “Users” on page 91. 

 Access Level: Enter a “B” in the first character of the Status field on the 
User form. That will turn on Access Level Security. You don’t have to turn 
on Access Level Security right away. You can always do it later. However, 
when you do turn on Access Level Security, be sure to do it by entering an 
“B” for the system supervisor first. 

 Multiple Login: Check the Multiple check box.  

 Control Permissions: By default, the form controls for which Controls 
Security is set up are denied, or disabled, for a new user. Grant the system 
supervisor permissions for all the form controls. Click the Control 
Permissions button on the Users form and click the “Grant to All” button on 
the Control Permissions dialog. 

 Menu Permissions: By default, a new user is denied access to all menu 
options. Grant the system supervisor permissions for all menu options. 
Click the Menu Permissions button on the Users form and click the 
“Include All” button on the Menu Permissions dialog. 

 Field Permissions: By default, a new user has full access to all fields on 
all forms. Therefore, you don’t need to do anything to give the system 
supervisor full Field Permissions. 

 Password Access: Check the Access check box on the Passwords form. 
That will turn on Password Access Security. You don’t have to turn on 
Password Access Security right away. You can always do it later. However, 
when you do turn on Password Access Security, be sure to do it by checking 
the Access check box for the system supervisor first. 

Turn on Security: After you have done the above, use the Admin tools dialog to 
turn on User Access Security and any other security tools you want. The next time 
the system supervisor runs HomeRun, they will need to enter their User ID and 
Password to login. 

Setting Up Other Users 
To set up security for other users, you follow the same basic procedure as for the 
system supervisor. However, you grant other users a lower security level, or less 
permission. Also, you can create Menu and Control Permission Groups to avoid 
having to set up Menu and Controls Security Permissions for each user. If you use 
Field Security, you must create Field Permission Groups. Permission Groups are 
explained in later sections of this chapter. 
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User Access Security 
User Access Security prevents unwanted entry into HomeRun. User Access Security 
requires users to enter a valid User ID and Password before they can access an 
application.  

Tip: When HomeRun is installed, User Access Security is turned off. You must 
enter users and their passwords on the Users form before User Access Security can 
be turned on through the Admin Tools dialog. See the “Users” section below. 

User Login 
When you run HomeRun with User Access Security on, HomeRun displays the User 
Login dialog.  

 
Enter your ID and password. If you press the escape key, you will exit HomeRun. 
You are allowed three attempts to enter a valid password. Upon the third invalid 
entry, you exit HomeRun.   

Temporary Password: When you enter a new user on the Users form, you enter a 
temporary password for the user. When the user enters HomeRun for the first time, 
the user will be prompted to enter a new password of the user’s own choosing. The 
purpose of this feature is to allow only the user to know their password after the 
system supervisor assigns a temporary password. 

Password Expiration: After you enter a valid password, HomeRun checks to see 
if it is time to change your password. It is time to change your password if the 
current date is equal to or greater than the date calculated by adding the Password 
Period in your User record to the date you last changed your password.   

Changing Your Password: You may enter a new password at any time by 
entering the “Change Character” after your password on the User Login dialog. The 
Change Character is a question mark, “?”, but the system supervisor can make it 
another character. The Change Character is described in “Password Setup” on page 
90.   

If a new password is to be entered, HomeRun displays the New Password dialog. 

New Password 
The New Password dialog requires you to enter a new password that conforms to the 
rules entered on the Password Setup form (see next section).   



90    Security HomeRun XL 3.5 Car Dealer Software 

 
After you enter a valid password, you must enter it again to confirm your entry. This 
is necessary because the entries are hidden from view and you may have entered 
something other than what you had intended. If you decide to not enter a new 
password, pressing the escape key or Cancel will exit HomeRun. 

Password Setup 
The Password Setup form on the Admin - Security menu is where you define the 
rules for entering new passwords. 

 
The fields on the Password Setup dialog are described below. 

 Warning Days: The number of days prior to the password expiration date 
that a warning dialog will be displayed. The warning shows the expiration 
date and allows a user to change passwords immediately. 

 Change Character: Holds the character that when appended to the 
password on the Login dialog, signifies that the user wants to enter a new 
password. The default Change Character is a question mark, “?”. 

 No ID in Password: Check this box to prevent users from putting their 
User ID in their password. 

 Minimum Length: A number from 1 to 10 that represents the least 
number of characters that can make up a password. 

 Maximum Length: A number from 1 to 10 that represents the greatest 
number of characters that can make up a password. 

 Prior Passwords: A number that represents how many prior passwords 
will be checked to prevent duplicate entry. An entry of one means that the 
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user’s current password cannot be reused. An entry of five means that the 
user’s current and four immediately preceding passwords cannot be reused. 

Users 
You access the Users form from the Users option on the Admin - Security menu. The 
Users form is where you enter and maintain information about the people who will 
be using HomeRun.   

 
 

Click the New button on the toolbar and enter a new user’s information in the fields 
shown. The fields on the Users form are described below. 

 User Number: A 10 character field used to identify the user in the 
organization.  

 User ID: A 10 character field which identifies the user to HomeRun. You 
enter your User ID on the Login dialog when you run HomeRun. 

 Status: A 10 character field used to store information about a user. You 
can use characters 2 through 9 to store any information you need. 

 

Access Level: The first character of the Status field is reserved to hold a user’s 
Access Level, if any. See “Access Levels” on page 94. 

 Login Status: Checked if the user is currently logged into HomeRun. If a 
user is logged-in when HomeRun is abnormally terminated due to a power 
failure, rebooting, etc., the contents of this field may be incorrect. If the user 
has not been given Multiple Login rights as described below, the user will 
not be allowed to re-enter HomeRun. In this case, the system supervisor 
will have to uncheck the user’s Login Status check box so that the user can 
re-enter HomeRun. 

 Multiple Login: If checked, the user can login to HomeRun from more 
than one computer at the same time. The user can also re-enter HomeRun if 
it terminates abnormally as described above. If unchecked, the user can only 
login if the Login Status field is unchecked.   

Multiple Login Tip: At least one user should be given the multiple login right so 
that all users would not be locked out of HomeRun if there is a power failure, etc. 
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 First Name: A 20 character field for the user’s first name. 

 Middle Name: A 20 character field for the user’s middle name. 

 Last Name: A 20 character field for the user’s last name. 

 Temporary Password: When a user is first added on the Users form, enter a 
temporary password in this field. Then, when the user enters HomeRun for 
the first time, the user will be prompted to enter a new password of the 
user’s own choosing.   

Temporary Password Tip: Any time you make an entry in this field, the next 
entry into HomeRun by the user will require the user to enter a new password. 

 Password Last Change Date: This field contains the date of the last 
password change.   

Password Last Change Date Tip: Blanking-out this field will cause the user to 
be required to enter a new password upon the next entry into HomeRun. 

 Password Period: This field contains a 3-digit number that represents the 
number of days that, when added to the Password Last Change date, is the 
date on which the user must next change passwords. Use this field to 
enforce your password change requirements.  

Password Period Tip: An entry of zero means that the user can keep the same 
password indefinitely. 

 Control Permissions Group: A 3 character field used to assign the user 
the same control permissions as all other members of the same group. This 
way, individual control permissions do not have to be assigned to each 
member of the group. See “Controls Security” on page 98. 

 Control Permissions: The Control Permissions button brings up the 
Control Permissions dialog where control permissions are assigned. If there 
is no entry in the Control Permissions Group field, you can click the 
Control Permissions button to select control permissions for the individual 
user. If there is an entry in the Control Permissions Group field, the Control 
Permissions dialog will only display the permissions assigned to the group. 
You may not change these assignments. The group’s control permissions 
may be changed through the Control Permission Groups dialog accessed 
from the Admin - Security menu. See “Controls Security” on page 98. 

 Field Permissions Group: A 3 character field used to assign the user 
the same field permissions as all other members of the same group. See 
“Field Security” on page 101. 

 Menu Permissions Group: A 3 character field used to assign the user 
the same menu permissions as all other members of the same group. This 
way, individual menu permissions do not have to be assigned to each 
member of the group. See “Menu Security” on page 95. 

 Menu Permissions: The Menu Permissions button brings up the Menu 
Permissions dialog where menu permissions are assigned. If there is no 
entry in the Menu Permissions Group field, you can click the Menu 
Permissions button to select menu permissions for the individual user. If 
there is an entry in the Menu Permissions Group field, the Menu 
Permissions dialog will only display the permissions assigned to the group. 
You may not change these assignments. The group’s menu permissions may 
be changed through the Menu Permission Groups dialog. See “Menu 
Security” on page 95. 
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Access Levels Security 
There is additional security for the Users and Passwords forms. On the Users form, 
the first character of the Status field is designated as the user’s Access Level. As 
soon as one user has an “B” in the first character of the Status field, Access Level 
security is turned on for HomeRun. 

Once Access Level security is turned on, the Access Level values in the first 
character of the Status field have the following meaning: 

 Blank: The user will not be allowed to access the Users or Passwords 
forms. 

 A-Z: The user can access the Users or Passwords forms, but the user will 
only be able to view users whose Access Level is blank or less than or equal 
to her own Access Level. Level A is the highest and Z is the lowest Access 
Level. A user cannot assign an Access Level higher than her own. If an “B” 
Access Level has not been assigned when a user enters the Users form, 
Access Level Security is turned off and the user can view all records and 
enter any Access Level. 

Warning: If you’re the system supervisor, be sure you turn on Access Level 
Security by assigning yourself a “B” Access Level before you give another user an 
“C”. If you turn on Access Level security by giving another user an “C” first, and 
you now can’t access the Users or Passwords forms, see “User Security Mistakes and 
How to Recover” on page 104. 
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Menu Security 
Menu Security prevents users from accessing menu options that the system 
supervisor decides they should not access. Users do not even see the options that 
they cannot access.   

Because Menu Security is assigned to individual users, Menu Security is disabled if 
User Access Security is turned off. 

Tip: When HomeRun is installed, Menu Security is turned off. This is done because 
users and their passwords must be set up and menu permissions must be assigned 
before Menu Security is turned on through the Admin Tools dialog.   

Warning: Do not turn on Menu Security before assigning Menu Security 
permissions. If you do, HomeRun will have no menu options when you run it. If this 
happens, see “User Security Mistakes and How to Recover” on page 104. 

Assigning Menu Permissions 
When a new user is added on the Users form, the user does not have permissions for 
any menu options. You must assign menu permissions to the new user. 

You can assign Menu Security permissions to users in two ways: 

 Individual Menu Permissions: You can assign menu permissions to a 
user on an individual basis through the Menu Permissions button on the 
Users form.   

1. Display the user’s record on the Users form. 

2. Click the Menu Permissions button on the Users form. HomeRun 
displays the Menu Permissions dialog.   

3. Follow the instructions in the “Menu Permissions Dialog” section 
below to assign individual permissions. 

 Group Menu Permissions: You can assign a user to the menu 
permissions that have already been assigned to a group of users.  

1. Display the user’s record on the Users form. 

2. Enter the code of the menu permission group to which the user should 
belong in the Menu Group field. With the cursor on the Menu Group 
field, press F2 or right-click on the field and select Picklist from the 
shortcut menu to see a list of the menu permission groups that you have 
set up. 

3. Follow the instructions in the “Menu Permission Groups Dialog” and 
“Menu Permissions Dialog” sections below to set up menu permission 
groups and assign group permissions. 
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Menu Permission Groups Dialog 
If a group of users will have the same permissions, you can create a menu 
permissions group and assign permissions to the group. Then, users can simply be 
assigned to this group instead of having to assign permissions to users individually. 

You reach the Menu Permission Groups dialog from the Admin - Security menu. 

 
Click the New toolbar button to add a record for a new menu permission group. The 
fields and button on the Menu Permission Groups dialog are described below. 

 Group Code: A three character code to identify the group. 

 Description: A descriptive title for the group. 

 Permissions: Click the Permissions button to bring up the Menu 
Permissions dialog to assign permissions to the group. See the next section. 

 Comments: A place for you to describe the group. 

Menu Permissions Dialog 
You use the Menu Permissions dialog to assign menu permissions to individuals and 
groups. You can reach this dialog from: 

 The Menu Permissions button on the Users form when you are assigning 
permissions for an individual. 

 The Permissions button on the Menu Permission Groups dialog when you 
are assigning permissions for a group. 
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The fields and control buttons on the Menu Permissions dialog are described below. 

 Menu: Displays the description of the menu that contains the menu option 
highlighted in the menu options list. 

 Menu Options List: The menu options from all menus are displayed in 
the menu options list. To the right of each menu option is the permission 
status. A blank means that the option will be included in the user’s menu.  
An “X” means that the option will be excluded from the user’s menu. By 
default, all menu options are excluded when the Menu Permissions dialog is 
first accessed for a group or individual. 

Tip: All menus, including shortcut menus, are listed in the menu options list.  

 Include / Exclude: Click on the Include option button to include the 
highlighted menu option in the user’s menu. Click on the Exclude option 
button to exclude the highlighted menu option from the user’s menu. 
Double-clicking on a menu option toggles its include/exclude status. 

Tip: Be sure to include the File/Exit menu option so that the user has a way to exit 
HomeRun. 

 Previous Menu / Next Menu: The menu options list contains all of the 
options of all of the menus in HomeRun. Clicking the Previous Menu 
button highlights the first menu option of the next menu up the list. Clicking 
the Next Menu button highlights the first menu option of the next menu 
down the list. 

 Include All / Exclude All: Clicking the Include All or Exclude All 
buttons changes the status of all menu options to “included” or “excluded”, 
respectively. 

 Copy Permissions: Clicking the Copy Permissions button brings up the 
Copy Permissions dialog where you can copy the permissions assigned to a 
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user or group and make them the permissions of the current user or group.  
See the next section. 

 OK: When you click OK, a record is created for each menu option for 
which permission has been granted. 

Copy Permissions Dialog 
The Copy Permissions dialog allows you to assign the permissions of a selected user 
or group to the current user or group. 

 

 Copy From User / Group: Click on the User option button if you want 
to copy the permissions of a user. Click on the Group option button if you 
want to copy the permissions of a group. 

 Users List: When the User option button is selected, the Users list is 
enabled. Highlight the user whose permissions you want to copy. 

 Groups List: When the Group option button is selected, the Groups list is 
enabled. Highlight the group whose permissions you want to copy. 

 Copy: Click Copy to copy the selected permissions to the Menu 
Permissions dialog. 

Controls Security 
Controls Security allows the system supervisor to enable and disable controls on 
forms and on the form toolbar by user. For example, if you have a button on a form 
that runs a process that only certain users are authorized to see, you can put Controls 
Security on that button so that it will only be enabled for authorized users. 

Because Controls Security is assigned to individual users, Controls Security is 
disabled if User Access Security is turned off. 

Tip: When HomeRun is installed, Controls Security is turned off. This is done 
because users and their passwords must be set up and control permissions must be 
assigned before Controls Security is turned on through the Admin Tools form.   

Assigning Permissions 
When a new user is added on the Users form, the user does not have permissions for 
any controls included in Controls Security. You must assign control permissions to 
the new user. 

You can assign Controls Security permissions to users in two ways: 
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 Individual Permissions: You can assign control  permissions to a user 
on an individual basis through the Control Permissions button on the Users 
form.   

1. Display the user’s record on the Users form. 

2. Click the Control Permissions button on the Users form. HomeRun 
displays the Control Permissions dialog.   

3. Follow the instructions in the “Control Permissions Dialog” section 
below to assign individual permissions. 

 Group Permissions: You can assign a user to the control permissions 
that have already been assigned to a group of users.  

1. Display the user’s record on the Users form. 

2. Enter the code of the control permission group to which the user should 
belong in the Control Group field. With the cursor on the Control 
Group field, press F2 or right-click on the field and select Picklist from 
the shortcut menu to see a list of the control permission groups that you 
have set up. 

3. Follow the instructions in the “Control Permission Groups Dialog” and 
“Control Permissions Dialog” sections below to set up control 
permission groups and assign group permissions. 

Control Permission Groups Dialog 
If a group of users will have the same permissions, you can create a control 
permissions group and assign permissions to the group. Then, users can simply be 
assigned to this group instead being assigned permissions individually. 

You reach the Control Permission Groups dialog from the Admin - Security menu. 

 
Click the New toolbar button to add a record for a new control permission group. 
The fields and button on the Control Permission Groups dialog are described below. 

 Group Code: A three character code to identify the group. 

 Description: A descriptive title for the group. 

 Permissions: Click the Permissions button to bring up the Control 
Permissions dialog to assign permissions to the group. See the next section. 

 Comments: A place for you to describe the group. 
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Control Permissions Dialog 
You use the Control Permissions dialog to assign control permissions to individuals 
and groups. You can reach this dialog from: 

 The Control Permissions button on the Users form when you are assigning 
permissions for an individual. 

 The Permissions button on the Control Permission Groups dialog when you 
are assigning permissions for a group. 

 
The fields and buttons on the Control Permissions dialog are described below. 

 Forms List: The captions of HomeRun’s forms with Controls Security are 
listed in the Forms list. Below each caption is a list of the controls for which 
permission can be granted. 

 Control Permissions: Double-click on a control to toggle the access 
permission. 

 Grant to All / Deny to All: Clicking the Grant to All or Deny to All 
buttons changes the status of all permissions in all forms to “granted” or 
“denied”, respectively. 

 Copy Permissions: Clicking the Copy Permissions button brings up the 
Copy Permissions dialog where you can copy the permissions assigned to a 
user or group and make them the permissions of the current user or group.  
See the next section. 

 OK: When you click OK, HomeRun creates records that store the 
permission assignments for each control. 

Copy Permissions Dialog 
The Copy Permissions dialog allows you to assign the permissions of a selected user 
or group to the current user or group. 
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 Copy From User / Group: Click on the User option button if you want 
to copy the permissions of a User. Click on the Group option button if you 
want to copy the permissions of a group. 

 Users List: When the User option button is selected, the Users list is 
enabled. Highlight the user whose permissions you want to copy. 

 Groups List: When the Group option button is selected, the Groups list is 
enabled. Highlight the group whose permissions you want to copy. 

 Copy: Click Copy to copy the selected permissions to the Control 
Permissions dialog. 

 

 

Field Security 
Field Security allows the system supervisor to prevent certain users from viewing or 
making changes to fields on forms.   

No Display: You can prevent data from specified fields from being displayed on a 
form for selected users.   

Display Only: You can also prevent specified fields from being edited by selected 
users.   

Group Not Individual: No Display and Display Only field security is applied to 
groups of users, not individual users.   

Field Security is disabled if User Access Security is turned off because Field 
Security requires entry of a User Id to identify a user’s Field Security permissions. 

Tip: When HomeRun is installed, Field Security is turned off. This is done because 
users and their passwords must be set up and field permissions must be assigned 
before Field Security is turned on through the Admin Tools form.   

Assigning Field Permissions 
You assign a user Field Security permissions by assigning the user to a field 
permission group.   

1. Follow the instructions in the “Field Permission Groups Dialog” and “Field 
Permissions Page” sections below to set up field permission groups and to 
assign group permissions. 

2. Display the user’s record on the Users form. 

3. Enter the code of the field permission group to which the user should 
belong in the Field Group field. With the cursor on the Field Group field, 



102    Security HomeRun XL 3.5 Car Dealer Software 

press F2 or right-click on the field and select Picklist from the shortcut 
menu to see a list of the field permission groups that you have set up. 

The field restrictions (no display, display only) can be assigned to any field in the 
HomeRun Data Manager. See the Field Permissions Page section below for an 
explanation of how to assign these restrictions to fields and in turn to field 
permission groups. 

Field Permission Groups Dialog 
Users that should have the same field permissions can be combined into field 
permission groups. Users are assigned to a permission group on the Users form. 

You reach the Field Permission Groups dialog from the Admin - Security menu. 

 
Click the New button on the toolbar to add a record for a new field permission group. 
The fields on the Field Permission Groups dialog are described below. 

 Group Code: A three character code to identify the group. 

 Description: A descriptive title for the group. 

 Comments: A place to describe the group. 

Field Permissions Page 
You use the Field Permissions page on the HomeRun Data Manager to assign field 
permissions (restrictions) to field permission groups. You reach the HomeRun Data 
Manager from the Admin menu. 
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The Field Permissions page is described below. 

 Groups List: The group codes and descriptions of all field permission 
groups are listed in the Groups list. To the right of each group code and 
description is the permission (restriction) status. A blank means there is no 
restriction for the group. A “d” means the Display Only restriction has been 
selected for this group. An “n” means the No Display restriction has been 
selected for this group. 

 Restrictions: Click on the None option button to signify that users in the 
highlighted group can view and edit this field. Click on the Display Only 
option button to signify that users in the highlighted group can view the data 
in this field but not make changes to it. Click on the No Display option 
button to signify that users in the highlighted group cannot view or make 
changes to the data in this field. 

When you leave the Field Permissions page, HomeRun stores the field permissions 
you have selected. 
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User Security Mistakes and How to Recover 
Setting up security is a little complicated. If you’re not careful, you can lock yourself 
out of HomeRun or make HomeRun’s menu disappear. This section describes some 
of the security mistakes we’ve seen and how to recover if the same mistakes happen 
to you.  

Tip: Security mistakes usually happen while you are getting to know HomeRun and 
before you have read this Security chapter. It’s not a good idea to “experiment” with 
HomeRun’s security features until you know how they work. 

Security Tables 
First, you need to know about the following HomeRun security files:  

 Security Tools Control Table File: SVPMADMINTOOLS2.DBF and 
SVPMADMINTOOLS2.CDX; this file contains a record for each tool listed 
on an application’s Admin Tools dialog. Each record in this table contains a 
logical field called “Control_On” that determines whether a tool is on or 
off. 

 Users Table Files:  SDATAUSERS.DBF, SDATAUSERS.CDX, and 
SDATAUSERS.FPT; these files contain a record for each person authorized 
to use HomeRun.  

These HomeRun security files are your keys to recovering from security mistakes. If 
you haven’t already done so, make backup copies of these files. You must make your 
backup copies before you ever start setting up HomeRun Security.  

Generally, the key to recovering from a security mistake is to copy your backup 
copies of these files over the “live” versions of the files in the HomeRunXL3 \DATA 
directory. In that way, you turn off HomeRun Security so that you can enter 
HomeRun and correct your security mistake. 

Security Mistakes 
Now, let’s look at some of the mistakes to avoid and how to recover from them. 

You Forget Your User ID and Password  
You’ve set up a User on the Users form. You’ve turned on User Access Security. 
You forget the User ID and Password, and you haven’t written them down. You’re 
locked out of your application: 

Recovery: Turn off User Access Security by copying your backup 
SVPMADMINTOOLS2.DBF and SVPMADMINTOOLS2.CDX table to your 
HomeRun XL 3.5\DATA directory. Enter HomeRun. Go to the Passwords form on 
the Admin – Security menu. Write down your User ID and Password. Turn on User 
Access Security again if you like through the Admin Tools dialog on the Admin – 
Security menu. 

You Turn on Access Levels Security for Another User 
before Giving Yourself an “B” Access Level 
You’ve set up a user on the Users form and given the user an “B” Access Level. 
Access Level Security is now on. Your Access Level is still blank. You can’t access 
the Users or Passwords forms. 
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Recovery: If you or the user with the “B” Access Level can enter HomeRun with 
that user’s ID and password, you can go to your User record and give yourself an 
“B” Access Level. That solves the problem. 

If for some reason you or the user can’t enter HomeRun with the user’s ID and 
password to correct the problem, your recovery is a little painful. First, you must turn 
off User Access Security by copying your backup SDATAUSERS.DBF, 
SDATAUSERS.CDX, and SDATAUSERS.FPT files to your HomeRunXL3.5 
\DATA directory. Of course, now you’ll now have to reenter all user data. 

Password Access: A variation on this mistake would be to make the same kind of 
mistake with the Access check box on the Passwords form. The recovery approach 
would be basically the same. 

You Turn on Menu Security before Assigning Menu 
Permissions 
You turn on Menu Security before assigning Menu Permissions to yourself. The next 
time you enter your application, there’s no menu. The only way you can exit 
HomeRun is with the infamous “three finger salute”. 

Recovery: If you can enter HomeRun with another ID and password that has access 
to the Users form, you can go to the Users form and assign Menu Permissions to 
yourself. That solves the problem. 

If for some reason you can’t enter HomeRun with an ID and password to correct the 
problem, you must turn off User Access Security and Menu Security by copying 
your backup by copying your backup SVPMADMINTOOLS2.DBF and 
SVPMADMINTOOLS2.CDX  files to your HomeRunXL3 .5\DATA directory. 
Then, enter HomeRun and assign Menu Permissions to yourself. 

No Exit Permission: A variation on this mistake is to forget to assign yourself or 
another user permission for the File menu Exit option. If you do that, the HomeRun 
window close box won’t work because it requires the File – Exit menu option to 
function. The recovery approach would be basically the same. 

Word to the Wise 
If you just read the “Security Mistakes” section of this chapter because you started at 
the beginning of the Security chapter and read each section in turn, we commend 
you. You’re going to do very well with HomeRun.  

However, if you’re sitting there locked out of your application with perspiration 
dripping from your forehead and this is the first time you’ve seen the “Security 
Mistakes” section, we hope you’ve learned your lesson.  

As a last resort, the person we have on file as the key management contact person 
can call us and we will give you the Master User Name & Password. This will work 
provided you haven’t changed the password for this user.  

Note: For logical reasons, the Master Management password will not be given 
to anyone else. This is to protect your security.
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Tips & Techniques 

Overview 
This chapter contains a collection of tips and techniques that will optimize your use 
of HomeRun. As you work with HomeRun, you may compile your own list of useful 
tips and techniques. If you do, please send them to the LeBlanc & Associates so that 
we can make them available to other HomeRun users. 

Increasing Form Speed 
HomeRun puts more functionality into its forms than any other comparable product 
by far. HomeRun forms include a related forms engine, a relational integrity engine, 
field security, form controls security, field validation, an audit trail, field messages, 
activity tracking, and more. 

While each of these features provides valuable functionality, they do slow down the 
operation of HomeRun forms. On some computers the reduction in speed may not 
justify the functionality provided by certain features. 

The purpose of the following sections is to describe changes you can make to 
HomeRun forms and environment that will increase form speed. 

Increasing Form Access Speed 
Form access speed refers to the time it takes for a HomeRun form to appear after it’s 
selected from a menu or by clicking the form image while another form is on top. 

The following subsections point out some ways you can speed up form access. 

Activity Tracking 
If your application doesn’t need Activity Tracking, turn it off on HomeRun’s Admin 
Tools dialog. You may not notice a marked increase in form access speed after 
turning off Activity Tracking, but every little bit you can do to increase form speed 
adds up. 

Controls Security 
If form controls security is not needed for an application, turning it off on 
HomeRun’s Admin Tools dialog will increase form access speed. 

Field Security 
If field security is not needed, turning if off will increase form access speed. You can 
turn off field security for HomeRun on the Admin Tools dialog reached from the 
Security popup on the Admin menu. 
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Increasing Save Record Speed 
When a user saves a record that has been edited on a form, HomeRun performs a 
check to make sure that the record’s primary key is not duplicated in another record 
in the table. 

 When a user saves a record that has been edited on a form, the HomeRun Audit 
Trail routine adds a record for every field that has been changed on the form to the 
Audit Trail table. Consequently, the Audit Trail feature slows down the saving of an 
edited record.   

Turn off the Audit Trail for HomeRun 

 If you don’t need the Audit Trail for any forms in HomeRun, you can turn it 
off on the Admin Tools dialog reached from the Security popup on the 
Admin menu. This will increase the speed at which records are saved. 

Increasing Delete Record Speed 
When a record is deleted on a form the HomeRun referential integrity routine is run 
and audit trail records are created. Both of these processes take time. 

Referential Integrity 
The HomeRun referential integrity routine is run to find and handle related records in 
other tables. The referential integrity routine can take a significant amount of time if 
a table has a lot of related child, grandchild, etc. tables. There is no good way to 
speed up the HomeRun referential integrity routine other than to forego the 
referential integrity check. However, it is not recommended that you abandon 
referential integrity unless absolutely necessary. 

Audit Trail 
When a user deletes a record on a form, the HomeRun Audit Trail routine by default 
adds a record to the Audit Trail table for each field in the deleted record’s primary 
key. If you have checked the Del Aud Trail - All Flds checkbox on the Data Manager 
Table - Properties page, an audit trail record is created for every field in the deleted 
record. If the table has child, grandchild, etc. related tables with the Cascade rule 
selected for deletes, records in the related tables are deleted and Audit Trail records 
are created for the deleted related table records. Consequently, the Audit Trail 
feature can slow down the deletion of a record significantly.   

Turn off the Audit Trail for HomeRun 

 If you don’t need the Audit Trail for any forms in HomeRun, you can turn it 
off on the Admin Tools dialog reached from the Security popup on the 
Admin menu. This will increase the speed at which records are deleted. 



 

HomeRun XL 3.5 Car Dealer Software   109 

 

 


